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PINES Circulation Policies and Procedures
Manual
PINES libraries have uniform circulation policies and procedures. According to the PINES Executive
Committee, this is a condition of participation [1999.05]. The procedures outlined herein represent the
decisions of the PINES Executive Committee. Some procedures will remain under local control, varying
with the speciﬁc situation of each library or library system. Individual patron abuse of general PINES
policies may be addressed at the local level by the system director [2012.03].
PINES Circulation Policies are approved by the PINES Executive Committee with input by the PINES
Subcommittees and the PINES Library System Directors. Any PINES Library System Director may suggest
a change to the existing policy to the Executive Committee for review.

About This Manual
This manual is based on the 2003 version of the PINES Circulation Policies and Procedures Manual that
contained complete descriptions of procedures in the existing automation system. The document was
brought up to date with references to Evergreen and completely revised in 2010 by a dedicated
workgroup made of up representatives of PINES member libraries. Since then, it has been updated
regularly to accommodate policy changes, new procedures due to changes in the software, and
additional information. In July of 2017, the manual was moved from a standard Word document format to
a Wiki format in order to improve change tracking.
About the 2010 PINES Circulation Policies & Procedures Project

Annotations
The policy has been edited with bracketed inline annotations (e.g., “[2014.05]”) which refer to the year
and month of the Executive Committee meeting at which the policy was decided. Only meetings where
an action item resulted in a policy addition or change are referenced. Discussion items or PINES staﬀ
reports are not referenced.
Meeting Agendas and Notes
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Conﬁdentiality
Georgia Conﬁdentiality Law: The Georgia Law (O.C.G.A. 24.12.30. Conﬁdential nature of library
records) prohibits the disclosure of any patron information, including titles checked out, amount of
ﬁnes/fees owed, and phone numbers/addresses. All PINES library staﬀ recognize the strict conﬁdentiality
of library records, and shall not disclose any information regarding library patrons unless legally
compelled. If proper legal documents are presented, a Library Director or designee must approve the
decision to release conﬁdential records.
Conﬁdentiality of Patron Information: Patron data such as email address, phone number or mailing
address cannot be used for purposes other than PINES transactions initiated by library patrons. Board of
Regents legal counsel has indicated that in their opinion that state and federal privacy laws prevent use
of PINES patron records for any business other than library transactions initiated by the patron. Allowable
use of data may include overdue notices, preminders, holds notices. Patron information may not be used
for county mailings, Friends of Libraries solicitations, and unsolicited e-mail communications from the
library staﬀ [2009.05].
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Registering Workstations
Before Evergreen can be used, a “workstation” must be registered. This process assigns a name to the
workstation that gets recorded in the activity / auditing logs in the Evergreen database and also aﬀects
what information you will see on certain screens. Most computers will only need a single workstation
name set up. However, it is possible to set up multiple workstation names associated with diﬀerent
branch locations for those staﬀ members who do work for multiple branches (such as catalogers or local
administrators).
Workstations can only be registered by staﬀ members with a LibraryManager or LocalAdmin type of
account. If a computer has multiple Windows logins (a diﬀerent Windows login for each staﬀ person that
uses it), then a workstation will have to be registered for each one.
To register the ﬁrst workstation on a computer, simply log in with a LibraryManager or LocalAdmin
account. You will be prompted to register a workstation before proceeding further.
If a workstation cannot be registered, verify that the date/time/time zone on the computer are correct,
and that JavaScript and Cookies are enabled in the browser.

Registering Multiple Workstations
Staﬀ such as LocalAdmins and Catalogers that support multiple locations, may have a need to log in as if
they are at a diﬀerent location. To do this, they may register workstations for each required location:
1. In Evergreen, go to Administration > Workstation > Registered Workstations.
2. Under “Register a New Workstation for This Browser” select the appropriate branch and type in a
workstation name.
3. Click Register.
4. Log out. The login screen should now show the new workstation in the dropdown list of registered
workstation names.
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Default Search Library
Whether you prefer your catalog searches from within the staﬀ client to default to all of PINES, to your
regional library system, or to a speciﬁc branch, you may set your preference on the Workstations page.
1.
2.
3.
4.

Click on Administration.
Click on Workstation.
Select using the Default Search Library Dropdown.
(There is no Save button, it will automatically save your preferences when you make the selection.)
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Function Bar
Pages that show tables of data (patron search results, checkin screens, holds pull lists, etc.) have
function bars across the top of them similar to this one:

Paging controls are located to the upper-right of the table, with arrows to navigate from page to page of
results and a Page dropdown to jump to a speciﬁc page. The “Rows 100” dropdown in the example allows
you to control how many rows you wish to see at once.
Some pages will also present you with action buttons (such as the Add to Bucket and Merge Patrons
buttons shown in the example above, or the Actions dropdown shown in the example below). You must
use the checkboxes in the table to select at least one row before you can use the action buttons.

Column Conﬁguration
To the far right of the paging controls, the single dropdown arrow on the right presents you with various
column conﬁguration options.
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Various search results tables may not default to the most useful columns. For instance, the patron search
results page may be easier to use if you change the columns to Card, Last Name, First Name, Middle
Name, Dob, and Primary Identiﬁcation, and you may wish to have the results sort by Last Name, then by
First Name.
To customize your columns:
1.
2.
3.
4.
5.
6.
7.

Click on the dropdown arrow at the top-right of the results table.
Select the desired columns.
Click 'Save Columns' (on the dropdown list).
Click 'Conﬁgure columns' (on the dropdown list).
Use Expand and Shrink to change column sizes.
Use Left and Right to change the column order.
Use the sort options to priortize how sorting should work. (A negative number will sort the column
in reverse order.)
8. Click 'Save columns.'

There is an option to “Reset Columns” - this will reset the visible columns, but it will not reset the column
widths or sort order.
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Receipt Printers
Receipt printers are attached to circulation workstations. These printers generate paper receipts much
like those printed by cash registers. Most models of receipt printers that will work with your model of
computer and operating system will work with Evergreen, and PINES staﬀ do not recommend or endorse
any particular one of them.
The Epson TM-T88V printer is the most popular receipt printer amongst PINES libraries. If you attempt to
order this printer, be aware that it comes in many conﬁgurations, most of which are designed to interface
with point of sale systems or kiosks and not with standard computers. The manufacturer number of the
correct conﬁguration is: Mfg# C31CA85084. You will need to download and install the Epson TM-T88V
printer driver separately when you connect the printer.

Browser Print Settings
By default, Evergreen will print using the browser's default printer and printer settings. Be sure to set the
margins to 0/minimal and that the paper size is set correctly.

Firefox Page Setup
Set the paper
1.
2.
3.
4.
5.

File > Print or Ctrl-P
Select the receipt printer
Switch to the Layout tab
Set paper size to roll
Select OK to test that it is sending to the correct printer.
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Set the margins
1.
2.
3.
4.

File > Page Setup
Format & Options tab: Make sure that “Shrink to Fit Page Width” is not checked.
Margins & Header/Footer tab: Set Margins to 0 and all Headers/Footers to blank.
Test printing a receipt from the staﬀ client to be sure it prints correctly.
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Chrome Page Setup
1.
2.
3.
4.
5.
6.

Menu (three vertical dots) > Print (Or Ctrl-P)
Select the receipt printer
Set paper size to Roll
Be sure scale is set to 100
Set margins to Minimum
Uncheck Headers and footers
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Automatic / Silent Receipt Printing
If the workstation only needs to print to the receipt printer, and never to another printer, the browser can
be conﬁgured to default to the receipt printer and auto-print so that the staﬀ person will not have to
acknowledge the print dialog box every time a receipt is printed. Or, if you opt to use Chrome with Hatch
installed, Hatch will handle the silent printing for you and you will not have to modify the browser
settings.

Chrome Auto-Print Setup
1. First: Set up your browser's printer settings (printer, paper size, margins, headers and footers) the
way you want them.
2. Close Chrome completely if it is currently open.
3. Create a Chrome desktop shortcut.
4. Right-click on the shortcut and select Properties.
5. Click the Shortcut tab and in the Target ﬁeld, add “ –disable-print-preview” to the end. It should
look like this: “C:\Program Files (x86)\Google\Chrome\Application” –disable-print-preview
6. Click OK
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Firefox Auto-Print Setup
1. First: Set up your browser's printer settings (printer, paper size, margins, headers and footers) the
way you want them.
2. Type about:conﬁg in the Firefox address bar.
3. Click the “I accept the risk!” button.
4. Right-click on the list, select New, then select Boolean.
5. Enter the preference name as “print.always_print_silent” (without the quotes) and click OK.
6. Set the preference value to true. (If the preference name already exists, ﬁnd it in the list, rightclick, then click Toggle to change between false and true.)

Hatch
See: Hatch Instructions
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Hatch
Hatch is an optional installable program that works with your browser to manage complex printing needs
(such as printing to diﬀerent printers under diﬀerent circumstances) and store local settings (such as
column conﬁgurations and custom print templates).
At this time, Hatch will only work with the Chrome browser. The instructions here are speciﬁcally
for Windows machines, but it is also available for Linux machines.

1. Update Java
Hatch requires the Java Runtime Environment (JRE) version 1.8 or higher. If you are unsure which version
you have, view your computer's list of programs. You can download the latest version at:
https://www.java.com/en/download/help/windows_manual_download.xml

2. Download and Install Hatch
If you had an earlier version of Hatch installed, you may want to uninstall it ﬁrst. If so, look for the
program called “Evergreen ILS - Hatch - Java based Print Service and Local Storage System.”
Hatch Native Messaging Application Installer Version 0.1.5
When you open Chrome, it should recognize that you have the new Hatch Extension installed and prompt
you to enable it, but if it does not, you may need to manually enable it:
1. Go to: the Menu > More Tools > Extensions
2. Click on the checkbox next to Hatch Native Messenger to enable it.
When Hatch is enabled, you will see a small yellow icon in the top-right corner of the browser.

3. Conﬁgure Hatch
1. Navigate to the web client site: https://gapines.org/eg/staﬀ (or https://next.gapines.org/eg/staﬀ for
the PINES test server).
2. Log in with your staﬀ account.
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3. Click on Administration > Workstation > Print/Storage Service (“Hatch”).
4. Check the “Use Hatch for Printing” box. (At this time, we do not recommend storing local settings
in Hatch.)
5. Return to the Home Page (you may need to re-set up your workstation and log in again).

4. Conﬁgure Printers
Go to Administration > Workstation > Printer Settings…
Default Tab
1.
2.
3.
4.

Set Printer to go to your laser printer.
Ensure that Paper Type is set correctly.
Adjust any other settings as you wish.
Click Apply Changes.

Receipt Tab
1. Set Printer to go to your receipt printer.
2. Ensure that your Paper Type is set to Roll Paper 80 x 297 mm (or whichever roll size your receipt
printer uses).
3. Set Automatic Margins to HARDWARE_MINIMUM.
4. Click Apply Changes.
Label Tab
(Most staﬀ will not have a label printer, so this step can be skipped.)
1.
2.
3.
4.

Set Printer to go to your label printer.
Ensure that your Paper Type is set to the appropriate type.
Set Automatic Margins to HARDWARE MINIMUM.
Click Apply Changes.

Mail Tab
1. Set Printer to go to whichever printer you wish to print mailing addresses to (this may be a laser
printer, label printer, or receipt printer, depending on your local conﬁguration).
2. Set Paper Source appropriately (ie, if using envelopes in a laser printer, choose Manual).
3. Set the Paper Type appropriately.
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4. Set the Page Orientation appropriately (relevant if printing to something such as an envelope.
5. Click Apply Changes.
Oﬄine Tab
1. Set Printer to go to your receipt printer.
2. Ensure that your Paper Type is set to Roll Paper 80 x 297 mm (or whichever roll size your receipt
printer uses).
3. Set Automatic Margins to HARDWARE_MINIMUM.
4. Click Apply Changes.

5. Force Printer Context
If your receipts appear to be printing to the default printer even though you have the receipt printer
conﬁgured, you may need to do this step as well.
1.
2.
3.
4.
5.

Go to Administration > Workstation > Print Templates.
Select the ﬁrst template type.
Choose the desired printer from the Force Printer Context (ie, Default or Receipt) dropdown.
Click Save Locally.
Repeat for each of the other templates.

If you export your print templates, the export will contain these printer context settings as well.

How to Reconnect Hatch if You Clear Your
Cookies
If you clear your browser cookies without having Hatch installed, any local settings you have stored will
be lost. However, if you have Hatch installed, you should be able to reconnect to Hatch using these steps
and retrieve your settings.
1.
2.
3.
4.
5.
6.
7.

Log in with a LibraryManager or LocalAdmin account.
Create a workstation and click Use Now to log in again.
Navigate to Administration > Workstation > Print/Storage Service (“Hatch”).
Check all three boxes.
Click on the Home icon.
You will be returned to the workstation registration screen again - click Use Now to log in again.
Your local settings should now be restored.
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Hatch Console Errors
If you are seeing unusual Hatch problems that you are unable to resolve, please go through the
Troubleshooting steps ﬁrst to ensure that all versions and settings are correct, and to gather console
error information to submit to the Help Desk for assistance.
Troubleshooting
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Print Templates
Most of the receipts that print from the Evergreen staﬀ client software are managed via the Print
Template Editor (Administration > Workstation > Print Templates) and can be customized on an
individual workstation basis. Typically, library systems will set up the receipts the way they want them to
print out on one workstation at a branch, then export the settings as a ﬁle and import that ﬁle to each of
the other workstations at that branch. Some library systems choose to set up diﬀerent types of
workstations (Circulation versus Technical Services, for example) diﬀerently depending on the type of
work that needs to be done.
If Hatch is installed receipts can be forced to use a speciﬁc printer settings (Administration > Workstation
> Printer Settings).
There are a few receipts, such as the Evergreen self-checkout receipts, that are controlled through
Notiﬁcation Action Triggers rather than through Print Templates. Changes to the notiﬁcation action
triggers are set on a PINES-wide basis and restricted to PINES staﬀ. Any requests for changes will need to
be reviewed for suitability for all PINES libraries.

Types of Print Templates
Bills, Current: Listing of current bills on an account.
Bills, Historic: Listing of bills that have had payments made on them. This used on the Bill History
Transaction screen.
Bills, Payment: Patron payment receipt.
Checkin: List of items that have been entered in to the check-in screen.
Checkout: List of items currently checked out by a patron during the transaction.
Hold Transit Slip: This is printed when a hold goes in-transit to another library.
Hold Shelf Slip: This prints when a hold is fulﬁlled.
Holds for Bib Record: Prints a list of holds on a Title record.
Holds for Patron: Prints a list of holds on a patron record.
Hold Pull List: Prints the Holds Pull List.
Hold Shelf List: Prints a list of hold that are waiting to be picked up.
In-House Use List: Prints a list of items imputed into In-house use.
Item Status: Prints a list of items imputed into Item Status.
Items Out: Prints the list of items a patron has checked out.
Patron Address: Prints the current patrons address.
Patron Data: Prints from the patron edit screen.
Patron Note: Prints a note on a patron's record.
Renew: List of items that have been renewed using the Renew Item Screen.
Transit List: Prints the list of items in-transit from the Transit List.
Transit Slip: This is printed when an items goes in-transit to another location.
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Customizing Print Templates
Clearing your browser's cache/temporary ﬁles will clear any print template customizations that you make
unless you are using Hatch to store your customizations. Be sure to export a copy of your customizations
as a backup so that you can import it as needed.
If you are modifying your templates and you do not see the updates appear on your printed receipt, you
may need to go into Administration > Workstation > Stored Preferences and delete the stored
preferences related to the print template that you modiﬁed (for example,
eg.print.template_context.bills_current).

General Workﬂow
1. In Evergreen, go to Administration > Workstation > Print Templates.
2. Select the Template Name of the receipt you wish to customize.
3. If you are using Hatch, you can choose diﬀerent printers for diﬀerent types of receipts with the
Force Content ﬁeld. If not, leave that ﬁeld blank.
4. Make changes in the Template ﬁeld.
5. Click Save Locally.

Content / Data
The various pieces of data that can be printed on a receipt are limited, and vary by receipt type.
See: Receipt Content Reference

Formatting
The print templates follow W3C HTML standards (see http://w3schools.com/html/default.asp) and can
make use of CSS and Angular JS to a certain extent.
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Print templates use variables for various pieces of information coming from the Evergreen database.
These variables deal with everything from the library name to the due date of an item. Information from
the database is entered in the templates with curly brackets. Diﬀerent types of print templates have
access to diﬀerent pieces of information. Example: {{checkout.title}}
Some print templates have sections that are repeated for each item in a list. For example, the portion of
the Checkout print template below repeats every item that is checked out in HTML list format by means
of the 'ng-repeat' in the li tag.
<ol>
<li ng-repeat="checkout in circulations">
<b>{{checkout.title}}</b><br/>
Barcode: {{checkout.copy.barcode}}<br/>
Due: {{checkout.circ.due_date | date:"short"}}<br/>
</li>
</ol>

Text Formatting
Goal
Original
Bold (HTML) hello
Bold (CSS) hello
Capitalize circulation
Currency
1
Italics
hello
Underline hello

Code
Result
<b>hello</b>
hello
<span style="font-weight:bold;">hello</span>
hello
<span style="text-transform:capitalize;">circulation</span> Circulation
{{1 | currency}}
$1.00
<i>hello</i>
hello
<u>hello</u>
hello
hello
Line Break hello there hello<br/>there
there
Horizontal Line
If you want to create a horizontal line going across your entire receipt, you can use the <hr/> (Horizontal
Rule) tag which creates a line similar to this:

Text Blocks with Outlines
If you want to create a box on your receipt that has an outline (solid, dotted, or dashed), you can use CSS
code to do so. For example:
This code creates a box with a solid, thin (1px) line: <div style="border:1px solid #000">Hello</div>
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This code creates the same box, but centers the text that is inside the box: <div style="border:1px solid
#000;text-align:center;">Hello</div>

You can change the solid line to a dotted line and make it thicker (3px): <div style="border:3px dotted
#000;text-align:center;">Hello</div>

You can also create dashed lines: <div style="border:2px dashed #000;text-align:center;">Hello</div>

Date Formatting
If you do not format dates, they will appear in a system format which isn't easily readable.
Code
Result
{{today}}
2017-08-01T14:18:51.445Z
{{today | date:'short'}}
8/1/17 10:18 AM
{{today | date:'M/d/yyyy'}} 8/1/2017
{{today | date:'longDate'}} August 1, 2017
Reference for additional date formats

Currency Formatting
Add “ | currency” after any dollar amount that you wish to display as currency.
Code
Result
{{xact.summary.balance_owed | currency}} $2.50

Conditional Formatting
You can use Angular JS to only print a line if the data matches. For example:
<div ng-if="hold.email_notify == 't'">Notify by email: {{patron.email}}</div>
This will only print the “Notify by email:” line if email notiﬁcation is enabled for that hold.
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Example for checkout print template that will only print the amount a patron owes if there is a balance:
<span ng-if=“patron_money.balance_owed”>You owe the library
${{patron_money.balance_owed}}</span>
See also: https://docs.angularjs.org/api/ng/directive/ngIf

Substrings
To print just a substring of a variable, you can use a *limitTo* function: {{variable | limitTo:limit}} where
limit is the number of characters you want.
Original
Code
Result
The Sisterhood of the Traveling Pants {{checkout.title | limitTo:10}}
The Sisterhood of th
123456789
{{patron.card.barcode | limitTo:-5}} 56789

Images
You can use HTML and CSS to add an image to your print template if you have the image uploaded onto
a publicly available web server. (It will currently only work with images on a secure (https) site.) For
example:
<img src="https://pines.georgialibraries.org/dokuwiki/lib/exe/fetch.php?media=logo.png"
style="width:150px;padding:5px;">

Sort Order
You can sort the items in an ng-repeat block using orderBy. For example, the following will sort a list of
holds by the shelving location ﬁrst, then by the call number:
<tr ng-repeat="hold_data in holds | orderBy : ['copy.location.name','volume.label']">

Subtotals
You can use Angular JS to add information from each iteration of a loop together to create a subtotal. This
involves setting an initial variable before the ng-repeat loop begins, adding an amount to that variable
from within each loop, and then displaying the ﬁnal amount at the end.
See example of a Bills, Current template with a Subtotal
See example of a Checkout Receipt with Amount Saved
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Public Holds Shelf Slips
There are diﬀerent ways to approach printing out receipts for items that will be left on a public holds
shelf for patrons to pick up themselves, but it is always important to remove as much patron information
from the printed receipts as possible. The attached example of a customized hold shelf slip print
template uses only the ﬁrst four letters of the patron's last name along with the last four numbers of the
barcode. It includes information on the hold arrival date and shelf expiration date, and how the patron
was notiﬁed, but not the details (ie, patron was notiﬁed by email, but does not print the email address).
Because staﬀ need to have the patron's phone number for those patrons who opt to be notiﬁed by
phone, the receipts for those patrons will print the phone number at the very bottom where it can be cut
oﬀ before the item is placed on the public shelf for pickup.
See example of a Hold Shelf Slip template designed for Self-Service (Public) Holds Shelves

Export / Import Customized Templates
To set up all workstations in a branch in the same way, set up one workstation's receipt templates
completely, then use the “Export Customized Templates” to save an external ﬁle that you can then
Import into other workstations.

Include Text Across Multiple Templates and Workstations
Evergreen allows certain blocks of text on the server to be conﬁgured to display across multiple print
templates without needing to update the workstations every time the text changes. For example, if a
library wishes to promote a diﬀerent event every day, the library could conﬁgure the print templates on
each workstation to include 'event text' and then would be able to change the content of that text each
day in one location to have the change appear in all locations.
1) Create the Included Text Setting
1. Go to: Administration > Local Administration > Library Settings Editor
2. Select the relevant library system or branch.
3. Add the text (HTML is allowed) to the include you wish to use (eg, event_text). The settings are:
1. Content of alert_text include
2. Content of event_text include
3. Content of footer_text include
4. Content of header_text include
5. Content of notice_text include
2) Update Print Templates
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1. Go to: Administration > Workstation > Print Templates
2. Select a template you wish to include the text on.
3. Edit the template to add the include tag (eg, {{includes.event_text}}). Possibilities are:
1. {{includes.alert_text}}
2. {{includes.event_text}}
3. {{includes.footer_text}}
4. {{includes.header_text}}
5. {{includes.notice_text}}
4. Click Save Locally.
5. Repeat for each other template you wish to include the tag on, and for each other workstation.
3) Update Included Text
When you wish to change the text that appears on each receipt, repeat step 1 (step 2 does not need to
be repeated).
If you wish to remove the included text, you can clear out the contents of the library setting. There is no
need to remove the tag from each of the workstations.

From:
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Receipt Content Reference
Any Type of Print Template
Tag
Notes
{{current_location.name}}
Current library's full name
{{current_location.shortname}} Current library's short name
{{current_location.email}}
Current library's email address
{{current_location.phone}}
Current library's phone number
{{includes.alert_text}}
Includes: Alert Text
{{includes.event_text}}
Includes: Event Text
{{includes.footer_text}}
Includes: Footer Text
{{includes.header_text}}
Includes: Header Text
{{includes.notice_text}}
Includes: Notice Text
{{today}}
Today's time and date - raw data
{{today|date:'short'}}
Readable time and date: 8/1/17 10:18 AM
{{today|date:'M/d/yyyy'}}
Date only: 8/1/2017
{{staﬀ.ﬁrst_given_name}}
Staﬀ ﬁrst name
See also: https://docs.angularjs.org/api/ng/ﬁlter/date
For each print template below, the sections that say “Inside ng-repeat loop” indicate that the tag must
appear inside the ng-repeat section of the print template and it will only work per item or per bill.

Bills, Current
Tag (Inside ng-repeat loop)
Notes
{{xact.summary.balance_owed}}
Balance remaining
{{xact.copy_barcode}}
Barcode
{{xact.id}}
Bill ID
{{xact.xact_start}}
Bill start date
{{xact.summary.xact_type}}
Bill type (circulation vs. grocery)
{{xact.summary.last_billing_note}}
Last billing note
{{xact.summary.last_billing_type}}
Last billing type
{{xact.summary.last_payment_note}} Last payment note
{{xact.summary.last_payment_type}} Last payment type
{{xact.title}}
Title
{{xact.summary.total_owed}}
Total billed
{{xact.summary.total_paid}}
Total paid
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Bills, Historical
Tag (Inside ng-repeat loop)
Notes
{{xact.id}}
Bill ID
{{xact.title}}
Title
{{xact.copy_barcode}}
Barcode
{{xact.summary.balance_owed}}
Balance remaining
{{xact.summary.xact_type}}
Bill type (circulation vs. grocery)
{{xact.summary.last_billing_type}}
Last billing type
{{xact.summary.total_owed}}
Total billed
{{xact.summary.total_paid|currency}} Total paid
{{xact.xact_start}}
Billing Start Date and Time
{{xact.xact_ﬁnish}}
Billing Finish Date and Time
{{xact.summary.last_billing_note}}
Last billing note
{{xact.summary.last_billing_type}}
Last billing type
{{xact.summary.last_payment_note}} Last payment note
{{xact.summary.last_payment_type}} Last payment type
{{xact.summary.total_owed}}
Total billed
{{xact.summary.total_paid}}
Total paid

Bills, Payment
Tag
{{patron.ﬁrst_given_name}}
{{patron.second_given_name}}
{{patron.family_name}}
{{patron.suﬃx}}
{{patron.card.barcode}}
{{patron.expire_date}}
{{patron.alias}}
{{patron.has_email}}
{{patron.has_phone}}
{{payment_applied}}
{{payment_total}}

{{change_given}}
{{payment_note}}
{{payment_type}}
{{amount_voided}}
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Tag
<div ng-switch="payment_type"> <div ng-switchwhen="cash_payment">Cash</div><div ng-switchwhen="check_payment">Check</div> <div ng-switchwhen="credit_card_payment">Credit Card</div> <div ng-switchwhen="credit_payment">Patron Credit</div> <div ng-switchwhen="work_payment">Work</div> <div ng-switchwhen="forgive_payment">Forgive</div> <div ng-switchwhen="goods_payment">Goods</div></div>
{{previous_balance}}
{{new_balance}}

Notes

Payment type better
display

Previous balance
Remaining balance

Tag (Inside ng-repeat loop)
Notes
{{payment.xact.copy_barcode}}
Barcode
{{payment.xact.summary.last_billing_type}} Last billing type
{{payment.xact.id}}
Payment ID
{{payment.amount}}
Payment received
{{payment.xact.title}}
Title

Checkin
Tag (Inside ng-repeat loop)
{{checkin.copy_barcode}}

Notes
Barcode
Call Number (if no call number, displays “Not
{{checkin.call_number.label||"Not Cataloged"}}
Cataloged”)
{{checkin.title}}
Title

Checkout
Tag
Notes
{{patron.ﬁrst_given_name}}
Patron First Name
{{patron.second_given_name}}
Patron Middle Name
{{patron.family_name}}
Patron Last Name
{{patron.suﬃx}}
Patron Name Suﬃx
{{patron.card.barcode}}
Patron Barcode
{{patron.expire_date}}
Account Expiration Date
{{patron.money_summary.balance_owed}} Amount Owed
{{patron.alias}}
Alias
{{patron.has_email}}
Has email? (true or false)
{{patron.has_phone}}
Has phone? (true or false)
Tag (Inside ng-repeat loop) Notes
{{checkout.author}}
Author
{{checkout.copy_barcode}}
Barcode
{{checkout.call_number.label}} Call Number
{{checkout.circ.due_date}}
Due Date
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Notes
Price
Title

Hold Pull List
Tag (Inside ng-repeat loop)
Notes
{{hold_data.author}}
Author
{{hold_data.copy.barcode}}
Barcode
{{hold_data.volume.label}}
Call number
{{hold_data.hold.hold_type}}
Hold type
{{hold_data.part.label}}
Part
{{hold_data.copy.location.name}} Shelving location
{{hold.title}}
Title

Hold Shelf Slip
Tag
{{call_number.label}}

Notes
Call Number
Hold available
{{today}}
date
Hold location
<div ng-switch on="hold.behind_desk"><div ng-switch-when="t"><strong>Private (Hold behind desk
Hold Behind Desk</strong></div><div ng-switch-when="f"><strong>Public Holds
or public holds
Shelf</strong></div></div>
shelf)
<ol><li ng-repeat="note in hold_notes|ﬁlter: {slip :
Hold Notes
't'}"><strong>{{note.title}}</strong><br/>{{note.body}}</li></ol>
{{hold.request_time | date:'M/d/yyyy'}}
Hold request date
Hold shelf expire
{{hold.shelf_expire_time | date:'M/d/yyyy'}}
date
{{author}}
Item author
{{copy.barcode}}
Item barcode
{{title}}
Item title
Returns true or
{{hold.email_notify}}
false ﬂag
Notiﬁcation phone
{{hold.phone_notify}}
number
Notiﬁcation SMS
{{hold.sms_notify}}
text number
{{patron.card.barcode}}
Patron barcode
Patron email
{{patron.email}}
address
{{patron.ﬁrst_given_name}}
Patron ﬁrst name
{{patron.family_name}}
Patron last Name
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Tag
{{patron.second_given_name}}
{{patron.alias}}

Hold Transit Slip
Tag
Notes
{{dest_address.city}}
Destination city
{{dest_courier_code}}
Destination courier code
{{dest_location.name}}
Destination full name
{{dest_location.shortname}}
Destination short name
{{dest_address.state}}
Destination state
{{dest_address.street1}}
Destination street address 1
{{dest_address.street2}}
Destination street address 2
{{dest_address.post_code}}
Destination zip code
{{hold.behind_desk}}
Hold behind desk
{{hold.request_time}}
Hold request date
{{author}}
Item author
{{copy.barcode}}
Item barcode
{{title}}
Item title
{{hold.email_notify}}
Notiﬁcation email (t or f)
{{patron.email}}
Notiﬁcation email address
{{hold.phone_notify}}
Notiﬁcation phone number
{{hold.sms_notify}}
Notiﬁcation SMS text number
{{patron.card.barcode}}
Patron barcode
{{patron.ﬁrst_given_name}}
Patron ﬁrst name
{{patron.family_name}}
Patron last Name
{{patron.second_given_name}} Patron middle name

Holds for Bib Record
Tag
Notes
{{holds[0].title}} Title
Tag (Inside ng-repeat loop) Notes
{{hold_data.author}}
Author
{{hold.copy.barcode}}
Hold target copy barcode
{{hold.hold.request_time}} Hold request date
{{hold.patron_barcode}}
Patron barcode
{{hold.patron_alias}}
Patron hold alias
{{hold.patron_last}}
Patron last name
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Holds for Patron
Tag (Inside ng-repeat loop)
{{hold.author}}
<div ng-if="hold.hold.email_notify == 't'">
{{hold.hold.requestor.email}} </div>
{{hold.hold.phone_notify}}
{{hold.hold.sms_notify}}
{{hold.hold.pickup_lib.name}}
{{hold.hold.request_time}}
{{hold.title}}

Notes
Author
Notify by email
(shows email only if selected)
Notify by phone (shows number)
Notify by SMS text (shows number)
Pickup library
Request date
Title

In-House Use List
Tag (Inside ng-repeat loop) Notes
{{ihu.copy.barcode}}
Barcode
{{ihu.num_uses}}
Number of uses

Item Status
Tag
Notes
{{copy.barcode}}
Barcode
{{copy['call_number.record.simple_record.title']}} Title

Items Out
Tag
Notes
{{patron.ﬁrst_given_name}}
Patron First Name
{{patron.second_given_name}}
Patron Middle Name
{{patron.family_name}}
Patron Last Name
{{patron.suﬃx}}
Patron Name Suﬃx
{{patron.card.barcode}}
Patron Barcode
{{patron.expire_date}}
Account Expiration Date
{{patron.money_summary.balance_owed}} Amount Owed
{{patron.alias}}
Alias
{{patron.has_email}}
Has email? (true or false)
{{patron.has_phone}}
Has phone? (true or false)
Tag (Inside ng-repeat loop) Notes
{{checkout.copy.barcode}} Barcode
{{checkout.circ.due_date}} Due date
{{checkout.title}}
Title
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Patron Address
Tag
Notes
{{patron.ﬁrst_given_name}}
Patron ﬁrst name
{{patron.second_given_name}} Patron middle name
{{patron.family_name}}
Patron last name
{{address.street1}}
Street address 1
{{address.street2}}
Street address 2
{{address.city}}
City
{{address.state}}
State
{{address.post_code}}
Zip code

Patron Data
Tag
Notes
{{patron.preﬁx}}
Patron name preﬁx
{{patron.ﬁrst_given_name}}
Patron ﬁrst name
{{patron.second_given_name}}
Patron middle name
{{patron.family_name}}
Patron last name
{{patron.suﬃx}}
Patron name suﬃx
{{patron.card.barcode}}
Patron barcode
{{patron.usrname}}
Patron user name
{{patron.alias}}
Patron holds alias
{{patron.dob | date:'M/d/yyyy'}}
Date of birth (formatted)
{{patron.juvenile}}
Is patron juvenile? (t or f)
{{patron.ident_type.name()}}
Primary identiﬁcation type
{{patron.ident_value}}
Primary identiﬁcation value
{{patron.ident_value2}}
Parent/guardian
{{patron.email}}
Email address
{{patron.day_phone}}
Main/day phone number
{{patron.evening_phone}}
Evening phone number
{{patron.other_phone}}
Other phone number
{{patron.home_ou.name()}}
Home library
{{patron.proﬁle.name()}}
Permission group (proﬁle type)
{{patron.expire_date | date:'M/d/yyyy'}} Expiration date (formatted)
{{patron.master_account}}
Is group lead account? (t or f)
{{patron.claims_returned_count}}
Claims returned count
{{patron.net_access_level.name()}}
Internet access level
{{patron.alert_message}}
Alert message
Tags in repeatable address block Notes
{{address.address_type}}
Address type
{{address.street1}}
Street (1)
{{address.street2}}
Street (2)
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Tags in repeatable address block Notes
{{address.city}}
City
{{address.state}}
State
{{address.post_code}}
Zip code
{{address.county}}
County
{{address.country}}
Country
{{address.valid}}
Is address valid? (t or f)
{{address.within_city_limits}}
Is address within city limits? (t or f)
Tags in repeatable stat cats block Notes
{{entry.stat_cat.name}} Stat cat name
{{entry.stat_cat_entry}} Stat cat value

Patron Note
Tag
Notes
{{note.value}}
Note contents
{{note.create_date}}
Note creation date
{{note.title}}
Note title
{{note.usr.card.barcode}}
Patron barcode
{{note.usr.ﬁrst_name}}
Patron ﬁrst name
{{note.usr.family_name}}
Patron last name
{{note.usr.second_given_name}} Patron middle name

Renew
Tag (Inside ng-repeat loop) Notes
{{renewal.copy.barcode}}
Barcode
{{renewal.circ.due_date}}
Due date
{{renewal.title}}
Title

Transit List
Tag (Inside ng-repeat loop)
Notes
{{transit.target_copy.barcode}}
Barcode
{{transit.source_send_time}}
Date sent
{{transit.dest.shortname}}
Short name of destination library
{{transit.source.shortname}}
Short name of sending library
{{transit.target_copy.call_number.record.simple_record.title}} Title

Transit Slip
Tag
{{dest_address.city}}

Notes
Destination city

PINES Documentation - https://pines.georgialibraries.org/dokuwiki/

2018/10/26 16:39

34/147

PINES Circulation Policies and Procedures Manual

From:
Tag
Notes
https://pines.georgialibraries.org/dokuwiki/
- PINES Documentation
{{dest_courier_code}}
Destination courier code
Permanent link:
{{dest_location.name}}
Destination full name
https://pines.georgialibraries.org/dokuwiki/doku.php?id=circ:workstations:receipt-content
{{dest_location.shortname}} Destination short name
{{dest_address.state}}
Destination state
Last update: 2018/10/11 15:15
{{dest_address.street1}}
Destination street address 1
{{dest_address.street2}}
Destination street address 2
{{dest_address.post_code}} Destination zip code
{{author}}
Item author
{{copy.barcode}}
Item barcode
{{title}}
Item title
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Barcode Scanners
Policy: Scanning Barcodes from Mobile Devices
PINES libraries allow patrons to present scannable electronic facsimiles of barcodes stored within
specialized apps (such as Key Ring or CardStar, both of which are available for iPhone and Android) on
hand-held devices in place of their physical library card. (Note: a photograph of a barcode is not
suﬃcient.)
When a patron presents a barcode on a hand-held device, library staﬀ will scan the barcode as if it were
a physical card. Some libraries are using older barcode scanners that cannot read the barcode oﬀ of the
device screen - in these cases, library staﬀ will type in the barcode.
After retrieving the patron account, staﬀ should ask the patron to verify their identity by conﬁrming a
piece of information on their account (such as name, phone number, email address, or date of birth).

Compatible Barcode Scanners
PINES libraries have reported that the following barcode scanners will scan patron barcode numbers oﬀ
of smartphones and other handheld devices with few issues:
Honeywell/Metrologic 1300G-2 USB
Library note: So far they have been great scanners and work for every device.
Library note: We are loving the Honeywell 1300G-2USB models. They have a trigger, but you can
program them to auto-scan. You can also change the volume of the beep they make – high,
medium, low or OFF! They scan barcodes from smartphones very well.
Library note: The stands are not included, we had to order those separately.
Honeywell/Metrologic Voyager 1400G-2D
Library note: Staﬀ have reported that they like these better than our normal scanners even for
regular barcodes.
Honeywell 1400GPDF USB
Library note: It requires a certain distance (4-5 inches) to scan correctly) and runs slightly slower
than some other scanners.
Honeywell/Metrologic VoyagerCG MS9540
QuickScan Imager Black, KBW, USB, WAND, RS232 Scanner with USB cable (90A052044)
Unitech MS250
Library note: Trigger-type scanner that requires the scanner to be touching the smartphone prior to
the trigger being pressed. They only cost around $40.
Unitech MS910
Library note: This is a wireless, bluetooth scanner, so may not be appropriate for all environments.
PINES libraries have reported that the following barcode scanners will not reliably scan patron barcodes
from handheld devices.
PINES Documentation - https://pines.georgialibraries.org/dokuwiki/

2018/10/26 16:39

36/147

PINES Circulation Policies and Procedures Manual

Honeywell/Metrologic MS9520
Honeywell/Metrologic Fusion MS3780
If you have any scanners to add to either of these lists, please email Terran McCanna
(tmccanna@georgialibraries.org) with details.
Metrologic Barcode Scanner Issues
If your scanner is inserting a b in front of the barcode and trailing a d, then you will need to restore your
scanner to its default properties.
Click here for Instructions

Using Your Mobile Device as a Barcode Scanner
Depending on the type of mobile device you are using, you may be able to install a virtual keyboard app
that will allow you to make use of your device's camera to scan barcodes.
One example is the Barcode & QR Code Keyboard developed by Nikola Antonov (available for Android
through the Google Play store). Once it is installed, follow the instructions to authorize it to run on your
device. To switch back and forth between diﬀerent virtual keyboards, you can do so in your device's
settings, or you should be able to click in a ﬁeld to display the keyboard and then pull down your
notiﬁcations bar at the top to see a “Select keyboard” message that will allow you to switch.
Once the virtual keyboard is installed, you can click in any ﬁeld on a web site to pull up the keyboard,
then click on the barcode icon. This will launch the scanner - once it recognizes the item's barcode, it will
enter the number into the ﬁeld that you originally clicked on.
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Browser Tools
The Evergreen web client is optimized to work with the current versions of Chrome and Firefox. Other
browsers are not oﬃcially supported. Your browser must be set to allow popups, cookies, and JavaScript.
Although we do not endorse one browser over the other, the Hatch local storage / printing program only
works with Chrome at this time. If you wish to have better control over printing or if you wish to save
local conﬁguration settings (column conﬁgurations, registered workstations, custom print templates, etc.)
without worrying about them being cleared out if you clear your cookies, then you will need to use Hatch
with Chrome.

Allowing Popups
Your browser must allow popups from gapines.org. You should see a small icon or message when a
popup is triggered, but if you do not, you may follow these steps to ensure that popups are allowed.

Allow Popups In Chrome
1.
2.
3.
4.
5.
6.
7.

Click on the menu icon (three vertical dots in the upper-right corner).
Select Settings.
Scroll to the bottom and click Advanced.
Under “Privacy and Security” click “Content settings.”
Click on “Popups and Redirects.”
Click the Add button next to Allow.
Type in https://gapines.org and click Add.

Allow Popups In Firefox
1.
2.
3.
4.
5.
6.
7.

Click the menu button (three horizontal lines in the upper-right corner).
Select Options.
Click on Privacy & Security.
Scroll down until you see “Block pop-up windows” in the Permissions section.
Click the Exceptions button.
Type in http://gapines.org and click Allow.
Click Save Changes.

Standard Browser Functions
Since the client is web-based, you can use common keyboard shortcuts and functions such as selections,
copy & paste, and right-clicks to access menus.
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15+ Keyboard Shortcuts
47 Keyboard Shortcuts That Work in All Web Browsers
Firefox and Other Browser Keyboard Shortcuts (Comparison Table)

Bookmarks and Proﬁles
The web client allows you to bookmark the pages that you use the most, and to use your browser's
existing functionality to build your own custom toolbars and even to use browser proﬁles for diﬀerent
activities.

Firefox Bookmark Extensions
You can use Firefox's built-in Bookmarks Toolbar to create a custom toolbar, or you can install free
extensions to customize your bookmark toolbars even further (Menu > Add-Ons > Extensions > Search).
There are many extensions available, but a few that you may ﬁnd useful are:
Multirow Bookmarks Toolbar: Makes your built-in Bookmarks Toolbar wrap to multiple rows.
More Bookmarks Toolbar: Adds a second bookmarks toolbar.
Bookmarks Favicon Images: Allows you to customize the icons for your bookmarks.

Chrome Bookmark Extensions
You can use Chrome's built-in Bookmarks Bar, or you can install free extensions to customize your
bookmark toolbars even further (Menu > More Tools > Extensions > Get more extensions). There are
many extensions available, but a few that you may ﬁnd useful are:
Bookmark Manager (by Google): More sophisticated bookmark tools including search capabilities
and folder suggestions.
EverSync: Another way to sync, backup, and restore your bookmarks.
Switchmark: Switch between multiple bookmark bars.

Firefox Sync
Firefox Sync is a free tool that allows you to synchronize your bookmarks, add-ons, and browsing history
across multiple computers and mobile devices. This is useful for staﬀ who work in multiple locations.
See: Set up Firefox Sync

Chrome People
Chrome People allows you to synchronize your bookmarks, add-ons, and browsing history across multiple
computers and mobile devices. This is useful for staﬀ who work in multiple locations. You can also set up
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Chrome proﬁles to separate work activities from personal activities or to separate diﬀerent types of work
activities, or for multiple staﬀ who need to use the same computer.
See: Chrome proﬁles / people

Export Bookmarks from Firefox
1. Click Bookmarks > Show All Bookmarks.
2. Click the Import and Backup dropdown menu.
3. Select Export Bookmarks to HTML.

Export Bookmarks from Chrome
1.
2.
3.
4.

In Chrome, click on the menu icon (3 vertical dots at upper-right corner of browser).
Click on Bookmarks > Bookmarks Manager.
Click the Organize dropdown menu.
Select Export bookmarks to HTML ﬁle.

Set Up Default Email
If you want to be able to click on a linked email address and have it launch a new email window in your
preferred email system (ie, Gmail, Microsoft Outlook, etc.), you may need to conﬁgure your browser so
that it understands what type of email window to open.

Default Email in Firefox
1.
2.
3.
4.
5.

Click on Menu (three lines in upper-right).
Select Options.
Scroll down to the Applications section.
Click the dropdown next to the “mailto” option to set your preferences.
(There is no Save button - it will save as soon as you make your selection.)
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Default Email in Chrome
By default, Chrome should launch whatever your Windows default email system is (for example, if
Windows is set to use a program such as Microsoft Outlook or Thunderbird as your email program). If you
want to change Chrome to launch Gmail instead, follow these instructions:
1. Open Gmail in Chrome and click the Protocol Handler icon (two overlapping diamonds) in your
browser's address bar.
2. When prompted to “Allow Gmail to open all email links?”, select “Use Gmail,” and click “Done.”
If Chrome is set to Gmail to default, but you need to change it back to your Windows default, you'll need
to clear out your Chrome settings:
1.
2.
3.
4.
5.
6.
7.

Click the menu icon (three vertical dots in upper-right).
Click Settings.
Scroll down to the bottom and click Advanced.
Scroll down to Privacy and Security.
Click on Content Settings.
Scroll down and click on Handlers.
Delete Gmail as the mailto handler.
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Shortcut Keys
Shortcut Key Description
F1
Check Out
F2
Check In
F3
Search Catalog
F4
Search Patrons
F5
Item Status
F6
Record In-House Use
F8
Retrieve Last Patron
F9
Reprint Last Receipt
Shift-F1
Register Patron
Shift-F2
Capture Holds
Shift-F3
Search for Record by TCN
Shift-F8
Retrieve Last Record
Ctrl-F2
Renew
Ctrl-N
New Window
Ctrl-T
New Tab
Ctrl-W
Close Tab
Ctrl-Shift-T
Undo Close Tab (open last closed tab)
Ctrl-F5
Refresh / Reload Page
Ctrl-Tab
Switch between browser tabs (from left to right)
Ctrl-Shift-Tab Switch between browser tabs (from right to left)
Ctrl-1
Switch to the First Tab
Ctrl-9
Switch to the Last Tab
Home
Go to Top of Page
End
Go to Bottom of Page
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Change Operator
If you click on the menu button on the upper-right corner of the interface, you'll see an option for
“Change Operator.”
The operator change dialog allows the selection of a Temporary, Staﬀ, or Permanent authtoken.
Temporary
Temporary logins expire within a few minutes of inactivity. This could be used when a Circulation staﬀ
person needs a Library Manager to log on in order to create another workstation, or it could be used for
quick testing purposes. Use the Restore Operator option to return to the original user.
Staﬀ
Staﬀ is a normal staﬀ login, but still allows the option to switch back to the original user.
Permanent
Permanent completely logs out the original user and does not oﬀer the option to switch back.
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Troubleshooting
Follow the steps on this page to verify that your software is up to date and conﬁgured correctly, and to
collect console messages that support staﬀ will ask for if you need to submit a help desk ticket.
If you click on any of the screenshots below, it will show you the screenshot in full size.
If you have used the Oﬄine Circulation module and have transactions that you are unable to upload from
the workstation they are on, make sure you export the transactions before clearing cookies/cache.

Refresh Screen / Restart Browser
Some issues, such as slow page load times while checking in a large stack of items, may be resolved by
simply refreshing the screen using the browser's refresh/reload button.
Other issues, such as a login screen appearing in an embedded frame, may be caused by timeouts and
can most easily be resolved by closing and reopening the browser.
If neither of these actions correct the problem you are seeing, continue to the next section.

Check Browser Conﬁguration
1. Make sure your browser is up to date.
In Chrome:
1.
2.
3.
4.

Go to Menu (3 vertical dots in upper-right corner of browser window).
Select Help.
Select About Google Chrome.
You should see a message saying “Google Chrome is up to date.”

In Firefox:
1. Go to Menu (3 horizontal lines in upper-right corner of browser window.)
2. Select Help.
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3. Select About Firefox.
4. You should see a messaging saying “Firefox is up to date.”

2. Make sure pop-ups are enabled.
In Chrome:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Go to Menu.
Select Settings.
Scroll down to the bottom and click Advanced.
In the Privacy and Security section, click Content Settings.
Click Popups. (You can also get to this screen by entering chrome://settings/content/popups in your
address bar.)
The main Popups setting should be Blocked.
Click the ADD link next to Allow.
Type in: gapines.org
Click Enter.

In Firefox:
1. Go to Menu.
2. Select Options.
3. Click Privacy & Security. (You can also get to this screen by entering about:preferences#privacy in
your address bar.)
4. Scroll down to the Permissions section.
5. “Block pop-up widows” should be checked.
6. Click the Exceptions button.
7. Type in: https://gapines.org
8. Click Save Changes.
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3. Make sure cookies are allowed.
In Chrome:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Go to Menu.
Select Settings.
Scroll down to the bottom and click Advanced.
In the Privacy and Security section, click Content Settings.
Click Cookies. (You can also get to this screen by entering chrome://settings/content/cookies in
your address bar.)
“Allow sites to save and read cookie data” should be on.
“Keep local data only until you quit your browser” should be oﬀ.
Click ADD next to Allow.
Type in: gapines.org
Click Enter.
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In Firefox:
1. Go to Menu.
2. Select Options.
3. Click Privacy & Security. (You can also get to this screen by entering about:preferences#privacy in
your address bar.)
4. In the History section, choose the option for “Firefox will… Use custom settings for history.”
5. “Remember my browsing and download history” should be checked.
6. “Accept cookies from websites” should be checked.
1. Alternatively: If you uncheck “Accept cookies from websites” then you must click Exceptions
and add https://gapines.org

3. Security Software and Cookies
If you have cookies enabled in your browser, but they are disappearing, check your computer's security /
antivirus software to see if it may be deleting your cookies on a regular basis.
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Verify Software Versions
This section is only relevant if you are using the Chrome Browser with Hatch.
1. Operating System
Hatch will only work with Windows 7, 8, and 10 at this time. If you are going to submit a Help Desk ticket,
include the version in your ticket, as well as whether it is 32 or 64-bit. You can ﬁnd this by:
1. Click on the Windows Start button.
2. Right-click on Computer.
3. Click on Properties.

2. Java
Verify that the Java Runtime Environment (JRE) is up to date (version 8 update 161 or higher). If you are
unsure which version you have, view your computer's list of programs or simply download and install the
latest version from:
https://www.java.com/en/download/help/windows_manual_download.xml

You can also check to be sure that your operating system is able to ﬁnd the path to Java:
1. Open up a command window (Start Menu, type in cmd).
2. Type in: java -version
3. You should see the Java version number listed. If there is a problem, you will see an error message.
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3. Hatch Program
Verify that you are running the correct version of Hatch (0.1.5). You can see this from your computer's
list of programs (Control Panel > Uninstall or change a program).
4. Hatch Extension
Verify that you are running the correct version of the Hatch Chrome Extension (0.1.5).
1.
2.
3.
4.
5.

Go to the Menu.
Select More Tools.
Select Extensions.
Scroll down to Hatch Native Messenger.
Verify that it is version 0.1.5 and Enabled.

When the Hatch Extension is installed and enabled, a small yellow icon should appear in the top-right
corner of the browser:

Clear Cache
Follow these directions to clear your browser cache:
In Chrome:
1.
2.
3.
4.
5.
6.
7.

Go to Menu.
Select History (on main menu).
Select History (on ﬂyout menu).
Click on Clear Browsing Data.
Set Time Range to All Time.
Check the box next to “Cached images and ﬁles” (other boxes can be left unchecked).
Click Clear Data.
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In Firefox:
1.
2.
3.
4.

Go to Menu.
Select Options.
Click on Privacy & Security.
In the Cached Web Content section, click Clear Now.

Clear Cookies
If you log in and see a blank page with the green bar across the top (aka, the “white screen of death”),
but nothing else will load, you may need to clear your browser's cache and cookies.
Before you clear cookies, be aware that clearing cookies in Firefox will cause you to lose your registered
workstations, print settings, and local settings. This will also occur in Chrome unless you are using Hatch
to store those settings.
In Chrome:
1. Click on the menu icon (three vertical dots in upper-right corner) and then History (or, CTRL-H).
2. Click Clear Browsing Data.
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Check the box next to “Cached images and ﬁles.”
Click the Clear Data button.
Enter this address in your address bar: chrome://settings/siteData
Use the trashcan icon to remove the cookies for gapines.org
Return to https://gapines.org/eg/staﬀ

If you have Hatch installed, use these directions to reconnect your browser to Hatch:
1.
2.
3.
4.
5.
6.
7.

Log in with a LibraryManager or LocalAdmin account.
Create a workstation and click Use Now to log in again.
Navigate to Administration > Workstation > Print/Storage Service (“Hatch”).
Check all three boxes.
Click on the Home icon.
You will be returned to the workstation registration screen again - click Use Now to log in again.
Your local settings should now be restored.

In Firefox:
1.
2.
3.
4.
5.
6.
7.

Click on the menu (three stacked lines in the upper-right corner).
Click Options.
Click Privacy & Security.
In the Cached Web Content section click the Clear Now button.
In the History section, click “remove individual cookies.”
Scroll down, select the gapines.org cookie folder, and click Remove Selected.
Return to https://gapines.org/eg/staﬀ (you will need to set up a new workstation).

Retrieve Console Messages
If you are having problems, please include screenshots and error messages from the console(s).
Chrome Console Messages:
1.
2.
3.
4.
5.
6.

Go to Menu.
Select More Tools.
Select Developer Tools. (This will open a pane on the right-side of your browser.)
Select the Console tab.
Change the “Default” dropdown to be sure that Verbose is checked.
Either take a screenshot or copy and paste the text that appears in the console when you see the
errors occurring. Be sure to include any of the errors that display in red.
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Hatch Extension Console Messages:
1.
2.
3.
4.
5.
6.
7.
8.
9.

In Chrome, go to Menu.
Select More Tools.
Select Extensions.
Check the box at the top of the screen that says Developer Mode.
Scroll down to Hatch Native Messenger.
Click on the link that says “background page.” (This will open a new window.)
Select the Console tab.
Change the “Default” dropdown to be sure that Verbose is checked.
Either take a screenshot or copy and paste the text that appears in the console when you see the
errors occurring. Be sure to include any of the errors that display in red.

Firefox Console Messages:
1. Go to Menu.
2. Select Web Developer.
3. Select Web Console. (This will open a pane across the bottom of your browser.)
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4. Click on the Console tab.
5. Either take a screenshot or copy and paste the text that appears in the console when you see the
errors occurring. Be sure to include any of the errors that display in red.

Console Error: Database Connection
If you still have a white screen after clearing cookies and cache, and the browser console is giving an
oﬄine database connection error, it is possible that the local database has become corrupted. You can
delete this database and the system will rebuild it the next time you log in.
In Chrome:
1.
2.
3.
4.
5.
6.
7.

Navigate to https://gapines.org/eg/staﬀ
Click Ctrl+Shift+I (alternatively, click on Menu > More Tools > Developer Tools).
Switch to the Application tab.
Expand the Indexed DB section.
Click on the “oﬄine - https://gapines.org” section.
Click the Delete database button.
Click the X in the upper-right corner of the section to close the tool frame.

In Firefox:
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Navigate to https://gapines.org/eg/staﬀ
Click Shift+F9 (alternatively, click on Menu > Web Developer > Storage Inspector).
Expand the Indexed DB section.
Expand the https://gapines.org section.
Right-click on “oﬄine (default)” and click the Delete option.
Click the X in the upper-right corner of the section to close the storage inspector frame.

Console Error: Unable to getItem from Hatch
If the browser console gives a message such as “Unable to getItem from Hatch: [ﬁeld name]. Retrieving
item from local storage instead,” it usually means that something Hatch-related has changed (settings,
reinstallation, disabled/enabled, etc.) and the browser can no longer ﬁnd the place where a local setting
had been stored. Please try these steps:
1. Administration > Workstation > Print/Storage Service (“Hatch”)
2. Click the “Copy Local Storage Settings to Hatch” button.
3. Log out and log back in again to check if the problem has been resolved.
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Patron Account Information
General Policies
Proper identiﬁcation must be presented to register [1999.05]. (See: Acceptable Forms of ID)
A library card is required in order to check out materials [1999.05, 2010.09]. Library card barcodes
may also be scanned from handheld devices [2014.05]. (See: Scanning Barcodes from Mobile
Devices)
Applicants for a card must complete and sign an application form, available at any PINES
participating library’s circulation desk. Alternatively, applicants may ﬁll out an online application
form prior to visiting the library to present their identiﬁcation and complete their application
[2014.05].
Patron account information is conﬁdential and cannot be used for purposes other than PINES
transactions. (See: Conﬁdentiality)

Residency
Library cards are free to all residents of Georgia. Persons who attend school, own property or are
employed full-time in Georgia are eligible for a free PINES card. Patrons of both PINES and nonparticipating Georgia public libraries may receive a PINES card. Users from non-participating
Georgia libraries shall have the same privileges as PINES users. Most PINES cards are valid for 2
years [1999.05].
Property owners who do not reside in Georgia are required to show proof of Georgia property
ownership, such as a tax bill or deed. Non-Georgia residents who are employed in Georgia or
attending school in Georgia are required to show proof of that employment or enrollment.
Out-of-state cards are available to persons living outside Georgia who do not meet the above
criteria for a $25 annual fee, payable at the time the card is issued. A temporary card is available
for a $12.50 fee and is valid for 6 months.

Responsibility
Signing a PINES card application denotes acceptance of responsibility for all ﬁnes and fees for lost
or damaged materials.
There is no minimum age for a child to receive a PINES card. A parent or legal guardian may
register a child [1999.05]. Parent or legal guardian must show proper ID to register a child. A
parent or legal guardian must sign the application for all children under 18. Signing a child’s PINES
card application denotes acceptance of responsibility for all ﬁnes, lost or damaged materials.
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Acceptable Forms of ID
An applicant for a new card is required to provide proper ID, which includes current, local address.
Acceptable ID for receiving a PINES card (3 choices):
1. Photo ID showing current local address, OR
2. Photo ID and one item from approved list (see below) showing current, local address (if photo ID
does not have correct address), OR
3. TWO (2) items from approved list showing current, local address.
Acceptable ID includes:
Valid driver’s license
Valid voter registration card
Valid matricula consular [2004.08]
Checks with pre-printed addresses
A utility bill (e.g., gas, electric, cable, internet, water/sewer, waste management)
Tax receipt or other piece of mail that shows the user’s name and present address.
Original documents are required with the exception of utility bills: because many people now pay their
utility bills online and no longer receive them on paper, patrons may present their online bill or statement
on their mobile device or printed from their utility’s web site [2015.12].
The registering library is responsible for ensuring that a correct address is obtained [2005.08].
Social Security Numbers are not used in PINES [2006.11].

Record Retention Policies
The legal department of the Board of Regents has indicated that public libraries are not mandated to
follow the USG data retention schedule for “Courtesy Borrowers Records” (a.k.a library patron
applications) [2014.09 BOR communication to the PINES Program Director]. Each library system should
develop its own record retention policies in accordance with the Secretary of State policy for voter
registration. Whether that information is recorded electronically or on paper forms is determined by each
library system.
Secretary of State’s Policy on Voter Registration
Georgia Records Act
Local Government Retention Schedules
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Creating New Patron Accounts
1. Check for Existing Accounts: To avoid creating a duplicate record, library staﬀ should always
search for the patron’s name in the Evergreen patron database before entering a new patron record. The
“Include inactive patrons?” box should be checked and the “Limit results to patrons in:” option should be
set to “PINES.” If an identical name is found, compare the address, birth date, and other identifying
information on the screen with the card application to determine if the patron is already registered in the
system.
If you ﬁnd the patron already has a record in the system, DO NOT create another record. Instead,
update the existing record with the corrected information.
If the patron’s information is outdated, update the information. (See: Updating Accounts)
If a patron has lost his or her card, issue a replacement card and charge the replacement fee. (See:
Lost Cards)
2. Create New Account: If the name is NOT found in the database, open the Register Patron screen.
The PINES user record can contain as many addresses as necessary, and notes and comments that
display to all PINES facilities. Required ﬁelds are:
Barcode
OPAC/Staﬀ Client User Name
Password
Verify Password
First Name
Middle Name is strongly encouraged but not required.
Last Name
Date of Birth
Primary Identiﬁcation Type (and information)
Home Library
Main (Proﬁle) Permission Group (See: User Permission Groups)
Privilege Expiration Date
Internet Access Level
Address (Type, Postal Code, Street (1), City
Response to the Voter Registration Survey Question (See: Voter Registration Survey)
See Also: Account Registration Field Descriptions
Staﬀ should not enter “placeholder” information (e.g. “N/A”, “No Middle Name”, “NMI” or the like) in any
ﬁeld when registering a patron. Please avoid punctuation such as quotation marks (i.e., James “Jimmy”
Jones) or parentheses (i.e. Martin (Alan) Smith) to indicate nicknames or preferred names. Unnecessary
spaces, misplaced apostrophes, and other typing errors can cause the search for a patron to return
incorrect results. If staﬀ wishes to record a nickname for local use, it could be added to the Alerts ﬁeld.
3. Save: When you are ﬁnished entering the patron’s information, click the Save button and ask the
patron to sign on the signature strip on the PINES card. It is a local decision on the part of each Library
System whether the PINES card will be given to the user at registration or be mailed [1999.10]. Consult
your circulation supervisor for the policy at your library.
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4. Records Retention: Follow local policy for storing signed applications. (See: Record Retention
Policies)

Patron Self-Registration Form
Patrons may ﬁll out an online application form on the PINES OPAC (Patron Self-Registration Form) to
register for a new library card. The patron must visit the library in person within 14 days to show proof of
ID so that the staﬀ can complete the registration form and issue the library card. In order to capture a
signature, library staﬀ can print oﬀ the completed patron account form from within the Evergreen Staﬀ
Client so that the patron may sign it and the staﬀ may initial it. These printouts should be stored with all
other registration forms following the library’s document retention policies. [2014.05] (See: Record
Retention Policies)
When the patron comes into the library to complete the registration process, staﬀ should:
1. Open the list of pending patron applications and retrieve the patron information (Circulation >
Pending Patrons).
2. In a separate tab, search to verify that the patron does not already have a PINES card. (If they do,
update the existing account rather than creating a new account.)
3. If no existing account exists, complete the patron registration form. Be sure to conﬁrm that the
information the patron entered matches the information on the ID that is presented.

Cloning a Patron with the Same Address
When a member of a family residing at the same household as an existing member is registering for an
account, the Save and Clone function can be used. The cloned patrons will automatically be grouped with
the ﬁrst patron.
1. Register the ﬁrst family member using the procedure outlined above (or, Edit the account of an
existing family member).
2. Click Save and Clone.
3. Complete the patron information as normal, modifying the information that was ﬁlled in
automatically as needed.

Sample Registration Forms
Sample Patron Form:
English
|
Spanish
Sample Institution Forms:
Sample 1
|
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Sample 2
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Patron Registration Form Field Descriptions
Barcode - Staﬀ should scan the library card barcode to enter. Accounts created for staﬀ use only
may be given a unique identiﬁer (Example: CLAYTN-HQSCIR1) other than a barcode.
OPAC/Staﬀ Client User Name - The username ﬁeld will be populated with the library card
number by default. Users may later choose to change their username to a text name via the OPAC.
Password/Verify Password - The password will be set to the last four digits of the ﬁrst phone
number provided after it is entered. If the patron does not have a phone, the system will create a
randomly-generated PIN. Staﬀ should provide the PIN to the patron with instructions to set a new
password for themselves via the OPAC and encourage them to do so as soon as possible.
First Name/Middle Name/Last Name - Staﬀ should enter names with an initial capital letter and
lowercase letters following (e.g., Jacky or Young). Use apostrophes in names as appropriate. (e.g.
O’Connor). Because of the large size of the PINES patron database, staﬀ are encouraged to enter
full ﬁrst, middle and last names. No nicknames should be added or listed. If the patron has a single
name (one word or one letter), enter that name in both the First Name and the Last Name ﬁelds
[2013.12].
If the patron does not have a middle name, leave the ﬁeld blank. Do not enter “NMN” or “No Middle
Name.” If you wish, you may add a note on the account that the patron does not have a middle name.
Suﬃx/Title - The suﬃx of names with Sr., Jr., III, should be entered in this ﬁeld. They may be
manually typed or selected from one of the options in the dropdown menu supplied.
OPAC/Staﬀ Client Holds Alias – This ﬁeld is provided as a privacy measure for patrons who
would not like their actual name to be used on hold slips (this is conﬁgurable by your Local System
Administrator). PINES/GPLS staﬀ does not recommend the use of this ﬁeld at this time.
Date of Birth - Staﬀ may enter the birthdate manually in the format MM/DD/YYYY, or may use the
supplied calendar tool to enter the date automatically. Birth date is a required ﬁeld [2010.02]. For
cases in which the patron date of birth is unknown, staﬀ will enter the dummy date “01/01/1901”
to allow the patron record to be saved [2011.09].
Juvenile – This checkbox will automatically be checked if the birthdate entered indicates that the
patron is under 18 years old [2006.05]. If the patron is a juvenile, the Parent/Guardian ﬁeld must be
ﬁlled out (at the time of this documentation, the Evergreen software does not require the
Parent/Guardian ﬁeld, but this policy indicates that it should be).
Primary Identiﬁcation Type - Staﬀ may choose either Driver’s License or Other from the
dropdown menu. PINES prohibits the use of patron Social Security Numbers for identiﬁcation
[2006.11].
Primary Identiﬁcation - Staﬀ should enter driver’s license number in the speciﬁed format (GAXXXXXXXXX), substituting the appropriate state abbreviation (e.g., FL, AL, SC, TN) for non-Georgia
drivers licenses. If the driver’s license was not used for primary identiﬁcation, enter relevant
information and explain in the Alert Message ﬁeld if necessary.
Driver's License Format: It is crucial that driver's licenses are entered in a consistent format in order
to alert staﬀ to duplicate accounts. All driver's licenses should begin with the two-letter state
abbreviation followed by a dash and then the number (“GA-123456789”).
Best Practice: If the ID is a driver's license from a state that uses dashes or other characters, enter it as
the two-letter state abbreviation followed by a dash and then the number as it is typed on the ID
(“FL-123-456-78-9-0”).
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Best Practice: If the ID used is not a driver's license, enter the unique alpha-numeric portion of the ID
and then follow it by a brief description of the type of ID. For example, “123456789 Military” or
“123456789 US Passport”. This way, if that ID is presented again at a later date, the staﬀ can search just
for the ﬁrst portion (“123456789”) without needing to know exactly how the description was entered.
Best Practice: If the ID belongs to a parent or guardian, enter it in the Primary Identiﬁcation Field and
then enter the name in the ﬁeld below.
Parent or Guardian – This ﬁeld is used to enter the name of a juvenile’s parent or legal guardian.
The person signing the application form for the juvenile is accepting responsibility for that library
card.
Best Practice: Enter the parent or guardian's name followed by the relationship (“Jane Smith, Mom”).
The parent or guardian's ID should be entered in the Primary Identiﬁcation ﬁeld.
Email Address - Staﬀ should encourage PINES users to provide email addresses for the beneﬁt of
receiving automated hold, overdue, and preminder (pre-overdue reminder) notices. An email
address stored in the system also allows the patron to use the automated “Forgot your password?”
feature in the OPAC. (NOTE: If an email address is entered, the patron will receive overdue notices,
as well as holds notices, via email. Final overdue notices will be mailed via U.S. Mail as required by
Georgia law).
Email checkout receipts by default? - If this box is checked, patron will automatically receive
emails instead of printed receipts at checkout time. (Staﬀ may choose to print out a copy as well.)
Daytime Phone - Day telephone number including area code. This is the patron’s preferred phone
number of contact and will be used for automated telephone notiﬁcations. When setting up a new
account, Evergreen will automatically assign the last four digits of this phone number as the
patron’s initial PIN for online account access.
Evening Phone - Night telephone number including area code.
Other Phone - Telephone number (usually, cell phone) including area code.
Home Library - Users will have system-wide borrowing privileges yet belong to a “home” library.
Staﬀ will designate the home library when they enter the user record in PINES. This ﬁeld will default
to the PINES location at which the user account is being entered.
Main (Proﬁle) Permission Group - The patron proﬁle determines the user’s loan period and ﬁne
rates. One of the proﬁles below will be assigned to each user. Some library systems may choose
not to use certain proﬁles (for example, Friend or Trustee). Library systems may also wish to direct
Circulation staﬀ to seek approval from a manager before assigning certain proﬁles (such as
Homebound or GLASS) – this would be a matter of local policy rather than a permissions setting in
the system. (See: User Permission Groups)
Privilege Expiration Date - Automatically set based on the Proﬁle Group, but may be edited by
staﬀ if necessary.
Internet Access Level - Defaults to Filtered, but may be set to Unﬁltered or No Access.
Active - Checked by default. If unchecked, the patron is no longer considered an active PINES
patron and will no longer be included in statistical reports. (See: Inactive Patrons)
Barred – (See: Barred Patrons)
Is Group Lead Account – Unchecked by default. If multiple patrons are grouped together
(example: a parent with children), one patron in the group will be the lead account.
Claims Returned Count - Shows the number of items marked Claims Returned that the patron
has accrued. After accruing 5 Claims Returned items, the patron may not have any more items set
Claims Returned [1999.10]. This count may be reset by editing the patron record.
Claims Never Checked Out Count – This feature is not used in PINES [2012.03].
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Alert Message - Staﬀ may enter an alert message that will appear when the account is retrieved.
Default Hold Pickup Location – If set, holds placed for this patron will default to be delivered to
this location. May or may not be the same as the Home Library.
Default Phone Number – Default phone number to be called when a hold is available for pickup
(optional).
Default SMS/Text Number – Default phone number to be used if SMS/Text notiﬁcation option is
selected for a hold.
Default SMS/Text Carrier – Phone service provider that the patron’s Default SMS/Text Number is
associated with. Some carriers are not listed because they will not accept SMS messages from the
Evergreen server.
Collections: Exempt – This feature is not used in PINES.
Hold is Behind Circ Desk – For patrons who pick up holds at a library branch that places holds for
pickup in a public area by default and who are concerned about privacy. If this box is checked, the
patron’s holds will be stored behind the circulation desk and not in a public area.
Hold Notiﬁcation Format (Phone and/or Email) – Sets default contact preference when holds are
available for pickup.
Address Fields
Mailing / Billing – Both are selected by default. An additional address may be selected if
necessary.
Type – Defaults to “MAILING.” Staﬀ must otherwise enter a short description of the address
(e.g. “Lake House”). For addresses that were imported from PINES’ previous automation
system, this ﬁeld will be marked “LEGACY ADDRESS.”
Postal Code – Standard 5- or 9- digit postal codes are accepted. City, State, and County
information are automatically populated for Georgia addresses when this ﬁeld is entered
(NOTE: the automatically entered information should be checked for accuracy, particularly
when one postal code covers portions of more than one city).
Street (1) - The number and street for the address.
Street (2) - Apartment, Lot, Suite, or additional address information.
City - City of residence.
County - County of residence (optional, but auto-populated by Postal Code entry). Although
optional, this is useful for statistical reports.
State - State of residence (if a Georgia Postal Code is entered, defaults to GA).
Country - Country of residence (defaults to USA).
Valid Address? - Checked by default. May be edited if an address is found to be invalid.
Within City Limits? - Based on patron-provided information, staﬀ may uncheck this box or
leave it checked (checked by default). This is useful for statistical reports.
New Address - Additional addresses may be added as needed. Addresses may also be
deleted, but the primary address may not be deleted. Note: For accounts that are grouped,
the owner of the address must be edited with the correct address or the patron must be
removed from the group to change a single patron’s address.
Statistical Categories - The purpose of statistical categories is to establish controlled vocabulary
that describes an individual user’s special characteristics for statistical analysis of circulation and
registration. The “Non-English Primary Language” category was determined to be a universal
statistical category in the PINES patron record [2006.05]. PINES does not require the use of
statistical categories. They may be created by individual library systems as needed by the Local
System Administrator.
Voter Registration - PINES uses the Survey function to electronically record patron voter
registration responses to be in compliance with Georgia law. (See: Voter Registration Survey)
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Additional Surveys – Additional Surveys may be created at the local library system level by the
Local System Administrator.
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User Permission Groups
Each patron and staﬀ account is assigned to a permission group (type of account) that controls what
functions they can use and circulation rules may apply.

Patrons Permission Groups
Patron - Normal users. Privilege is two years. This user will be blocked if a total of $10 or more is
owed. User is billable [1999.05]. User may have up to 50 holds at a time. This proﬁle can also be
used for users who live out-of-state but work, attend school, or own property within Georgia.
Digital Only - This is meant for students whose schools have partnered with their local libraries to
register them. This permission group provides access to electronic materials (databases, ebooks,
etc.) that the library provides, but does not allow checkout of physical materials. Privilege is one
school year. [Pilot began May 2017, approved to continue May 2018.]
See also: More information about Digital Only accounts
Friend – A library user who is a member of a local Friends of the Library organization. Privilege is
one year. User is billable, and has same use parameters as the Patron proﬁle.
GLASS – This proﬁle type is restricted to patrons who are already registered with GLASS and have
a KLAS ID number. PINES staﬀ can create these accounts, but most will be created and managed
by AMLAS staﬀ. GLASS users are allowed up to 50 checkouts at a time. Privilege is for two years.
Standard checkout period is for 30 days with 1 renewal. Homebound users are not billed overdue
ﬁnes, but will be charged for lost, damaged, or long overdue items. 15 holds are allowed at once.
GLASS users may place holds on DVDs that have descriptive audio tracks and on large-print books,
and these items will be routed to the AMLAS oﬃce (STATELIB-B) for packaging and shipping
through the United States Postal Service’s Free Matter for the Blind program. [2014.05 and
2014.07]
See also: GLASS Patron Proﬁle Instructions
Homebound – Homebound users are individuals who are unable to visit a library in person without
great diﬃculty and who either have materials delivered to them by a library’s outreach department
or picked up for them by a designated representative. Cards should not be issued to users that live
outside of a library’s service area. Individuals who assist the Homebound user by picking up
materials from the library on behalf of the Homebound user should be listed in the account’s Alert
ﬁeld. Homebound users are allowed up to 50 checkouts at a time. Privilege is for two years.
Standard checkout period is for 30 days with 1 renewal. Homebound users are not billed overdue
ﬁnes, but will be charged for lost, damaged, or long overdue items. 15 holds are allowed at once.
[2014.05]
Each Library System's Director shall determine which of their staﬀ members are permitted to
create user accounts with the Homebound proﬁle.
Libraries may use discretion in the case of a user who is able to visit the library but may need
longer than a normal check-out period to process information.
Each library system shall determine whether Homebound cards are kept at the library or kept
by the user or user’s representative.
Because each library system may decide how long to keep its own items on their own holds
shelf, a library system may choose to decide to keep their own items for Homebound patrons
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on their holds shelf for a longer period of time to better assist patrons who are unable to pick
up the items quickly. Libraries should not keep items from a diﬀerent library system on their
holds shelf longer than the standard maximum of 7 days.
Institution – A library system may choose to issue an Institution card to any institution or
organization with a regular daily population that is housed long term. Examples include school
media centers, day care centers, nursing homes, assisting living facilities, and jails [2014.12].
Each library system shall develop an application form diﬀerent from the standard patron
application form that enters the institution into a legal contract with the library ensuring that
the institution will take responsibility for any ﬁnes and fees. The application form must be
signed by an authorized representative of the institution and should be approved by the
Library System Director or an authorized representative of the library system. A library
system should not issue an Institution card to any institution located outside the library’s
service area.
When entering data into the account registration form, the name of the primary
representative of the institution should be entered as the name on the account. The
Institution’s name should be entered as the ﬁrst line of the Address. Any respresentatives of
the institution who are authorized to check out materials on that card should be listed in the
account’s Alert ﬁeld.
Privilege limit is 1 year. This user will be blocked if a total of $10 or more is owed. User is not
billed overdue charges, but is billed for Lost, Damaged, and Long Overdue items. User may
have up to 50 items checked out at a time. User may have up to 50 holds at a time.
Circulation period is 42 days with no renewals [2015.05]. Note: The 42-day circulation period
was implemented 5/4/2015. Items checked out prior to this have a 30-day circulation period.
Library systems may choose to store an Institution’s physical card at the library.
NonResident – A library user who resides in the state of Georgia, but outside of the areas served
by PINES libraries. Privilege is one year. This user will be blocked if a total of $10 or more is owed.
User is billable. User may have up to 50 holds at a time.
OutOfState – A library user who resides out-of-state. Privilege fee is $25. Privilege limit is 1 year.
This user will be blocked if a total of $10 or more is owed. User is billable. User may have up to 50
holds at a time.
PaymentPlan – Temporary status for individuals making payments on fees that would otherwise
automatically go to collections. A library system can notify the collection agency not to pull patrons
with this proﬁle. The proﬁle should be returned to a permanent status after full payment of the fee.
User has identical privileges to Patron proﬁle [2008.11].
Restricted – A library user with restricted library use. Privilege limit is 1 year. This user may have
only 2 items checked out simultaneously. This user will be blocked after 1 overdue item and if a
total of $0.01 is owed. User is billable. User may have up to 5 simultaneous holds.
Restricted cards are intended for temporary or probationary purposes. This may include seasonal
workers, RV park residents, the homeless or in lieu of fully barring a patron from library use.
PINES should accept as proof of residency, a letter on oﬃcial letterhead from agencies serving the
homeless, temporary group homes (such as family violence shelters), and similar institutions.
StaﬀNoPerm – A library user who has staﬀ member privileges on borrowing items, but does not
have staﬀ-level permissions [2009.05].
Temp – A library user who resides in the area for a limited period of time, but lives permanently
outside of the state. Privilege limit is 6 months. Privilege fee will be ½ ($12.50) of the fee charged
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for OutOfState users. This card carries limited borrowing privileges. This user may check out up to
5 items simultaneously. This user will be blocked after 1 overdue item and if a total of $0.01 is
owed. User is billable. User may have up to 5 simultaneous holds.
TempRes6 – A library user 18 years of age or older. User has identical privileges to Patron proﬁle,
except that privilege expires after 6 months, and card must be renewed at that interval. This
proﬁle may be used for college students or military personnel who move frequently. There is no fee
to receive this card.
TempRes12 – A library user 18 years of age or older. User has identical privileges to Patron
proﬁle, except that privilege expires after 12 months, and card must be renewed at that interval.
This proﬁle may be used for college students or military personnel who move frequently. There is
no fee to receive this card.
Trustee – A library user who is a member of a Library’s Board of Trustees. Privilege is 2 years. User
is not billable. Same use parameters as Patron proﬁle.

Staﬀ Permission Groups
Each staﬀ member should generally be given the lowest level permission group which allows them to
manage their responsibilities. Additional permissions may be granted to an individual to increase their
access without moving them to a higher permission group (for example, a CIRC1 may also be granted the
ability to create and run reports), but speciﬁc permissions cannot be removed from an individual without
moving them to a lower permission group.
The Director of each library system must designate a Cat1 and a LocalAdmin. Those accounts can only be
set up and updated by PINES staﬀ. The LocalAdmin will manage the rest of that library system's
accounts.
Chart of Staﬀ Permissions
Acquisitions
ACQUADMIN, ACQFIN, ACQLIST, ACQREC, ACQSEL - Permissions are assigned and explained
by PINES staﬀ during Acquisitions training
Cataloging
Cat1 - Library staﬀ must be trained by PINES staﬀ prior to being given Cat1 permission, and
each library system must have a designated Cat1 who is responsible for overseeing all of
that library system's cataloging functions. Cat1 accounts can only be updated by PINES staﬀ
at the request of the library system's Director.
Cat2, Cat3 - Other technical services staﬀ whose permissions are managed by a library
system's Cat1.
Circulation
LibraryManager - Each library system designates LibraryManagers (usually branch managers
or circulation department managers) who have all circulation-related permissions. These
accounts are managed by a library system's LocalAdmin.
Circ1, Circ2, Circ3, Circ4 - Varying levels of circulation staﬀ. These accounts are managed by
a library system's LocalAdmin.
LocalAdmin
Each library system designates a LocalAdmin (usually the library system's technical lead /
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system's administrator).

Test Groups
Digital Only - This is a test permission group that should only currently be used by Twin Lakes,
West Georgia, and Henry County Library Systems for a student digital card pilot project [2017.05].

Permission Groups No Longer In Use
Class - This is no longer used in PINES [2003.02].
Homeschool – The Executive Committee rejected the creation of a new Homeschool proﬁle with
additional permissions beyond that of a standard Patron proﬁle [2014.05]. Homeschool students
should be assigned the standard Patron proﬁle.
Outreach – This is no longer used in PINES [2014.12].
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Editing / Updating Patron Accounts
Updating a Patron Record
To edit a user record, retrieve the patron record (Search > Search for Patrons). Verify that all information
is up to date and in the correct format. See: Patron Registration Field Descriptions

Card Expiration and Renewal
Most types of PINES cards are valid for 2 years. The system will notify staﬀ that a card is about to expire
(within 30 days) or has already expired by placing an alert on the patron record which displays whenever
the patron record is retrieved. Patrons can see their own expiration dates when logging into “My
Account” via the OPAC. Patrons that include an email address in their account will be sent an automated
courtesy notice 30 days prior to their account expiration date.
At renewal time, staﬀ should ask to see current identiﬁcation and update the patron’s information
(address, phone number, etc.) This is a good time to add or update the patron’s email address, and
conﬁrm that the user’s full name is entered. Be sure to correct any typos or capitalization problems in the
record, and verify that the Driver's License is in the correct format (GA-123456789).
The patron must resolve all outstanding ﬁnes and fees in order to renew her/his card. [2009.12]
If a user’s account is set to expire during the proposed renewal period for items, Evergreen will not allow
a renewal past the patron expiration date.

Incorrect Addresses
When mail is returned to the library due to an incorrect address, the patron’s address should be marked
as invalid. These users will then be omitted from the overdue notice reports.
1. In order to identify the users who need corrected address information, the “valid” checkbox beside
the address in the user record must be unchecked. Staﬀ should do this whenever mail is returned.
2. The patron record will be marked with an (Invalid Address) message.
3. Once this procedure is under way, each library may periodically wish to run a report of users with
invalid addresses, in order to determine which items are still checked out and presumed lost, in
case those items should be discarded.

When a PINES Patron Moves to Another PINES Library System
If a patron moves from one PINES library system to another, change the home library of the patron from
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the old library system to the new library system and update address, telephone numbers, and hold
pickup location in the patron record. The patron may keep the same card if they wish to, however it is
recommended that staﬀ replace the patron’s card with one from the new library system, as electronic
reference database access is often based on patron card number. (Please note that the $2 card
replacement fee is waived in this scenario.) Although it won't count as a new registration, the patron will
now be included in reports of all patrons registered in the new library system.
If a patron moves from one library to another within the same system, the home library and hold pickup
location should be changed in the patron record and the address and telephone information should be
updated.
Georgia law mandates that library staﬀ oﬀer patrons the opportunity to register to vote when receiving or
making changes to their library accounts.

Patron Record Deletion / Deceased Patrons
Evergreen contains a feature that allows the complete deletion of patron accounts, but this is restricted
to extreme cases and may only be performed by PINES staﬀ at the request of a library director. In the
case of deceased patrons, the suggested alternative is to change the name on the patron account to ﬁrst
name “Deceased,” last name “Patron,” which will eﬀectively anonymize that person’s account without
aﬀecting circulation or billing history.

When A Staﬀ Member Leaves Employment
When a PINES staﬀ member leaves employment, his or her account should be immediately changed from
a staﬀ permission group to the standard Patron permission group. The email address and other contact
info should be updated to reﬂect personal rather than business information.
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Voter Registration Survey
PINES libraries will keep records of voter registration and declination electronically within the PINES user
record. Each time a user record is created or modiﬁed, a patron must be asked if he/she wishes to
register to vote, and his/her decision must be recorded in the designated ﬁeld.
PINES libraries should include the following question on the PINES card application: If you aren’t
registered to vote, would you like to register to vote here today? Select one:
I am already registered to vote
I want to register to vote
I do not want to register to vote
I do not wish to register to vote, but will take a registration form home
I am not eligible to vote
All public libraries are required to keep this information for two (2) years by the Georgia Secretary of
State’s oﬃce. Georgia public libraries must continue to follow all rules and requirements of the Motor
Voter Act as speciﬁed by the Georgia Secretary of State’s Oﬃce.

Mailing in Voter Registration Applications
To ensure timely processing of applications, completed voter registration applications must be mailed to
the Secretary of State's oﬃce:
LIBRARIES ARE REQUIRED TO MAIL ANY COMPLETED VOTER REGISTRATION APPLICATIONS WEEKLY. THE
EXCEPTION TO THIS RULE IS DURING THE 15 DAYS PRIOR TO ANY REGISTRATION DEADLINE WHEN
SUBMITTAL OF ANY COMPLETED APPLICATIONS TO THE SECRETARY OF STATE ELECTIONS OFFICE MUST
BE MADE DAILY.
Election calendars can be found at: http://www.sos.ga.gov/electionconnection
If you do not have any completed applications, you do not need to submit anything to the
Secretary of State’s oﬃce.
Mail the applications in the pre-paid envelope provided by the Secretary of State's oﬃce. You may
either include a daily recap sheet (or similar agency identifying sheet) with your submittal, or you
may print or stamp the following on the pre-paid envelope:
Supervisor and Facility Name
Address
Phone Number
More information may be found at the Georgia Secretary of State’s website:
http://sos.ga.gov/index.php/Elections/election_connection (click on the Public Libraries link)
Information from the head of the Elections Division of the Secretary of State's oﬃce given to the State
Librarian:

PINES Documentation - https://pines.georgialibraries.org/dokuwiki/

2018/10/26 16:39

71/147

PINES Circulation Policies and Procedures Manual

If an individual registering to vote does not have ID, you should accept the registration and submit it. The
best practice is to take whatever they give you; it is their responsibility, not yours, to ensure proper
completion of the form and presentation of ID. The county registration oﬃce will ﬂag the account, and
the voter will be required to show ID upon ﬁrst instance of voting.

Reporting Registration and Declination Numbers
Libraries must report to the Secretary of State’s Oﬃce regarding the numbers for those registering to
vote and those declining; there are two options for reporting this information.
1. Ordered List ItemLibraries may use the Daily Recap Forms furnished by the Secretary of State’s
Oﬃce (click here to download the Daily Recap Form); these must be mailed at least weekly except
in the period beginning 15 days prior to the registration deadlines when they must be mailed daily;
OR
2. Libraries may e-mail the number of newly registered voters and those declining to register to vote
to Melody Johnson at mjohnson@sos.ga.gov. This information must be emailed at least weekly
except in the period beginning 15 days prior to the registration deadlines when the numbers must
be e-mailed daily and the completed voter registration forms must be mailed daily.

Additional Information and Instructions
Voter Registration Procedures for PINES Libraries (PowerPoint from Secretary of State's Oﬃce)
Supply Order Form
Secretary of State's 'Election Connection' site for additional information
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Inactive Patrons
PINES will mark users “inactive” in the patron database three (3) years after the last use of a PINES
library card, if the card has not been blocked [2002.12]. A server process runs nightly which identiﬁes
inactive patrons and marks them as such.
A PINES patron account is considered “inactive” if all of the following conditions are met:
a patron has no items currently out.
there are no bills on the patron’s account.
there has been no activity such as circulations, renewals, check-ins, payment of bills, placement of
holds for 3 or more years.
In keeping with current ideas about what constitutes library “use,” PINES also deﬁnes a user as “active”
when she/he accesses any of the following non-circulation-related services with her/his library card
[2008.11]:
Use of library computers (unless “circulated”)
In-library wi-ﬁ access
E-books or audiobook downloads
GALILEO databases (whether or not authenticated through the OPAC).
Logging into a user account in Evergreen
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Blocked and Barred Patrons
User Status - Blocked
If a patron’s record is automatically blocked due to excessive ﬁnes ($10.00 or above), the patron's name
will appear in red when the patron record is retrieved. The patron will not be able to check out or renew
items until the reasons for the block are resolved.
Block reasons are recorded in the Messages section of the patron’s account. Blocks are automatically
removed when the reason for the block is resolved. Blocks may also be manually removed by
highlighting the block(s) and going to Actions for these Penalties > Remove from Patron.
A staﬀ member may also create a manual block on a patrons account if necessary.
1.
2.
3.
4.
5.
6.
7.

Retrieve the patron account.
Open the Messages tab.
Click the 'Apply Penalty / Message' button.
Select 'Block' as the Penalty Type.
Add a concise note explaining the block and how it can be removed.
Enter the staﬀ name or initials in case there are any questions about the block.
Click OK.

User Status - Barred
Barred is a status that should be reserved for serious oﬀenses, such as theft of library materials. Each
Library Director or designee shall decide the circumstances under which a patron may be barred, and
must enter the reason for the barring in an alert message (Messages > Apply Penalty / Message > Alert)
or Note (Other > Notes > Add New Note) on the patron account [1999.10].
It is PINES policy that only the library that barred the patron can unbar said patron. If a barred patron
presents items for checkout at other than the library that barred the patron, he/she should be directed to
speak with that library to resolve outstanding issues and restore library privileges.
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Multiple Patron Accounts / Patron Record
Merging
If a patron is discovered to have multiple accounts, the accounts may be merged. This facilitates patron
database cleanup and helps to address the issue of outstanding charges on multiple accounts. To see a
patron’s previously active cards, staﬀ may click the See All button on the Patron Edit screen.
Patron record merging is restricted to PINES staﬀ due to the intensive nature of the updates involved.
Contact the PINES staﬀ via the Help Desk with the accounts that should be merged and which of the
accounts is current. PINES has conﬁgured patron merging to preserve all history on all merged records
[2012.03].

Requesting an Account Merge
If you encounter two or more accounts that belong to the same patron, please submit a Help Desk ticket.
We will need:
Patron Barcodes (Indicate which one should be the “Lead” or primary barcode. If one of the
accounts is in collections, then that account must be marked as the lead account.)
Patron Name
Ideally, we would also appreciate:
Patron Date of Birth
Patron ID and/or Parent Information
If the account names or other identifying information do not match, please explain what criteria you used
to identify them as the same patron. We will store this in the help desk in case for record-keeping
purposes in case there are any questions in the future about why speciﬁc accounts were merged.
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Lost / Stolen Cards
If a patron comes into the library and reports his or her PINES card lost or stolen, ask for ID to verify the
name of the patron. Use the patron search function to search for and retrieve the patron record. Click
Edit, then click the Replace Barcode button and assign a new card to the patron.
If a patron reports a card lost or stolen by telephone (or is otherwise not present), place a temporary
Block on the account (Messages > Apply Penalty / Message > Block) until the patron is able to come into
the library to pick up a new card. This will prevent anyone else who ﬁnds the card from using it.
The charge for a replacement card is $2 [1999.10]; the patron may pay at the time the new card is
issued, or the fee may be placed on the patron’s record (according to local policy).
If the patron uses his/her card number as his/her username for PINES account access, consult with the
patron as to whether the username should be updated to the new card number.
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PINES Staﬀ Accounts
PINES library staﬀ members are granted passwords for access to the PINES database via the Evergreen
staﬀ client. PINES member libraries are required to change PINES passwords once a year [2002.09], and
at the library’s discretion when a key staﬀ member with high-level access leaves, or if an employee
leaves under hostile circumstances [2005.08].
Libraries may choose to use shared logins for circulation staﬀ, but using individual logins for each staﬀ
member allows for better tracking and accountability. If a shared login is used, the password should be
changed when anyone who uses that shared login leaves employment. If individual logins are used, the
account should be changed from a staﬀ account to a patron account if the staﬀ member leaves
employment.
Staﬀ with a 'Library Manager' account may update circulation staﬀ accounts. Staﬀ with a 'Local Admin'
account may update all other types of accounts except Cat1 accounts. Local Admin accounts may only be
created by PINES staﬀ at the request of the library director, and Cat1 accounts may only be created after
a staﬀ member has successfully completed required Cat1 training. Staﬀ with Local Admin or Cat1
accounts should submit help desk requests when the accounts need to be renewed or otherwise updated.
Although staﬀ members cannot edit their own accounts in the staﬀ client, they may log in to the My
Account portion of the online catalog to update their password, search preferences, etc.
In the event of presentation of a National Security/FBI letter requesting information under the PATRIOT
ACT, any PINES Director may give his/her system password access to PINES [2006.01].
Staﬀ need to have at least one Working Location set. To set the working location, go to the staﬀ account
and click Other > User Permission Editor, then select the appropriate location(s).
See also: Staﬀ Permission Groups
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Alerts, Notes, and Messages
There are several ways you can attach messages to a patron's account. The preferred ways to add
messages to an account are:
Messages that should be visible to patrons: Other > Notes > Add New Note (Check “Patron
Visible”)
Messages that should be visible to staﬀ only, and appear when patron is retrieved: Messages >
Apply Penalty / Message > Alert
Messages that should be visible to staﬀ only, but do not need to appear when patron is retrieved:
Other > Notes > Add New Note (Do not check “Patron Visible”)

Alerts
Add or update an alert by editing the patron's account and typing your alert in the Alert Message ﬁelds.
This is the least preferable method of adding alerts because there may only be one Alert Message at any
time and there is no saved history of prior alerts. If duplicate accounts are merged, this type of alert may
be lost.
The Alert Message will appear when you ﬁrst pull up the patron's account and you can view it again while
in the patron's account by clicking Other > Display Alert and Messages.

Notes / Patron Message Center
To add a Note in a patron's account, retrieve the patron's account then click Other > Notes > Add New
Note. A pop-up window will open where you can choose to make the note visible to the patron (or not),
and enter a title for the note and the note itself. It is good practice to enter your initials (the date and
library will be stored automatically). Multiple notes may be stored at once. Notes cannot be edited, but
they may be deleted if they are no longer relevant.
If the patron logs into “My Account,” he or she will see any Notes that are patron-visible in the Messages
screen. Staﬀ can see if patrons have read the messages left in the patron message center by going to
Other > Message Center.
The system will also automatically leave notes in the Patron Message Center (see Automated
Notiﬁcations) that staﬀ can see by going to Other > Message Center.

Messages
Messages may be used to add notes that can be edited, to apply penalties, and to block accounts.
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Click the Messages button in the patron's account to view, add, and archive messages.
To add a new messages, click the “Apply Standing Penalty/Message” button. A pop-up window will open
where you may choose to add a Note, an Alert, or a Block to an account. Type in a descriptive message
and your initials, then click Apply.
A “Note” will add a message to this list, but it will not be visible unless you go to this screen.
An “Alert” will add a message to this list that will also display when you ﬁrst open a patron's
account or when you click Other > Display Alert and Messages. (This is the best way to add an alert
to a patron account because it can be archived for posterity.)
A “Block” will add a message to this list that will also display when you ﬁrst open a patron's
account or when you click Other > Display Alert and Messages. It will also prevent the patron from
checking out items, placing holds, or renewing items.
The system will also add certain messages to this interface when diﬀerent actions occur. For example, if
staﬀ clicks the “Invalid Address” button in a patron's account, the system will create a message here that
says “Patron has an invalid address.”
After an issue has been resolved and the message is no longer relevant, click the Messages button,
select the relevant message line item, click “Actions for these Penalties/Messages” and then choose
either “Remove Penalty/Message” (which will delete it) or “Archive Penalty/Message” (which will
inactivate it and move it to the Archived list at the bottom of the screen).
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User Buckets
User Buckets can be created to temporarily hold a group of patrons that need to be reviewed or updated.
For example, you may wish to create a user bucket of potential duplicate patron accounts that you wish
to review further, or a user bucket for a family that needs to have all of their addresses updated, or a
user bucket for all new accounts that are created so that they can be double-checked for completeness
later.

Adding Patrons to User Buckets
Patrons can be added to a User Bucket from the Patron Search Screen or the Circulation Menu.

Patron Search Screen
1.
2.
3.
4.

Perform a patron search.
Select the patron(s) to add to a bucket and click the Add To Bucket button.
Choose the bucket to add the patron to or create a new bucket.
A message will show at the bottom right of the screen that says, “X # of patrons have been added
to bucket Y.”
5. To view the bucket open the Circulation menu and choose User Buckets.
6. In the Bucket View tab click the Buckets button and choose the bucket to view.

Circulation Menu
1. Open User Bucket from the Circulation menu.
2. In the Bucket View tab click the Buckets button and choose the bucket to add the patron(s) to or
create a new bucket.
3. Leaving the bucket being used open in the Bucket View tab, click on the Pending Users tab.
4. Scan the patron barcode in the Barcode box. The patron will be added to the list below.
5. Highlight the patron and right click or use the Actions menu and select Add To Bucket.
6. Switch back to the Bucket View tab. You will see that the patron has been added to the open
bucket.

Actions
Batch Edit All Users
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Only staﬀ with LibraryManager or LocalAdmin permissions can use the Batch Edit feature. Clicking on the
Batch Edit All Users button allows you to update certain ﬁelds on all of the patrons in the current bucket
at once. Give the update a name in the “Name for edit set” ﬁeld and then you can update:
Home Library
Main Proﬁle (Patron Permission Group)
Internet Access Level
Barred Flag
Active Flag (PINES has scripts that run nightly to mark patrons active or inactive, so this will not
typically be used by PINES staﬀ)
Juvenile Flag (PINES has scripts that run nightly to change juvenile accounts to adult accounts when
they turn 18, so this will not typically be used by PINES staﬀ)
Privilege Expiration Date (Account expiration)

View Batch Edits
This allows you to see the list of batch edits that have already been done on the current bucket.

Roll Back Batch Edit
This allows you to select a previous batch edit that was done to the current bucket and undo it.

Batch Modify Statistical Categories

PINES Documentation - https://pines.georgialibraries.org/dokuwiki/

2018/10/26 16:39

81/147

PINES Circulation Policies and Procedures Manual

For those libraries that use patron stat cats, this will allow all patrons in the current bucket to be updated
at once.

Individually Edit Selected Users
Select the patrons you wish to edit from the list and click on Actions > Individually Edit Selected Users.
Each of the patron accounts you selected will open in a new tab.

Remove Selected Users From Bucket
Select the patrons you wish to remove from the current bucket and click Actions > Remove Selected
Users From Bucket. The patrons you selected will be removed from the bucket.
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"My Account" Access
https://gapines.org/login
PINES users have access to selected areas of their personal patron record, including checkouts,
ﬁnes/bills, holds placed, and other information through the My Account section of the OPAC.
Patrons have the option to automatically store their own checkout history and access it through their My
Account login. This option is turned oﬀ by default, but patrons may turn it on by logging into their
accounts and selecting the appropriate option. Library staﬀ cannot see the patron’s checkout history
through the staﬀ client. [2015.12].
Access to the personal patron record is available only through the PINES library card number and
password or personal identiﬁcation number (PIN) for each user, as all library records are conﬁdential in
nature. The assigned PIN should be provided to the user at the time of library card registration, and staﬀ
will advise the patron to login to the OPAC and change their password to one of his or her choosing as
soon as possible. The user may also use the My Account options to select a text username to use in lieu
of the library barcode for OPAC access.
The PINES patron has the ability to change his/her own PIN/password after accessing the record with the
correct library card number and PIN/password. Some patrons may need staﬀ assistance in remembering
the current PIN/password to access their patron record.
Users may reset their PIN in person at any PINES participating library with proper identiﬁcation. Patrons
may reset their passwords from the My Account page if they have a valid email address on ﬁle via 'Forgot
your password?' functionality [2006.05]. Patrons may also request a password reset by phone by calling
a PINES library. The patron must be able to provide the library staﬀ person with the barcode number, full
name, date of birth, and either address or phone number. Library staﬀ should encourage patrons to log in
to the OPAC and change the assigned password to a password of their own choosing as soon as possible
for security and privacy purposes [2014.12].
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Circulating Items
Checking Out Items
Renewing Items
Checking In Items

General Policies
Circulation Matrix
See: Circulation Matrix (Recurring Fine Amounts, Loan Durations, and Renewal Counts)

Circulation and Hold Data Retention
With a few exceptions, circulation and hold data that has been resolved/closed is archived by the system
after one year. Archiving this data does not aﬀect statistical reporting, such as total number of
circulations per item, circulation staﬀ, circulation workstation, and circulating library.
Circulation data with outstanding ﬁnes or fees, including Lost and Long Overdue, is retained. Circulation
information is also retained for those patrons that opt to have the system store their circulation history.
However, when looking at the “Show Last Few Circulations” item screen or the “Show Cancelled Holds”
patron screen, data older than a year is not be displayed.

Default Item Price
Items that have never had a price assigned use $25.01 as the default item price [2007.12]. That is, if the
price in the database is NULL, $25.01 is used when assigning Lost, Long Overdue, and Damaged charges.
If the price in the database is 0 or blank, then no item price will be automatically used when assigning
Lost, Long Overdue, and Damaged charges, and staﬀ will need to add the price to the bill manually.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation
Permanent link:
https://pines.georgialibraries.org/dokuwiki/doku.php?id=circ:circulation:circ
Last update: 2018/10/11 15:15

PINES Documentation - https://pines.georgialibraries.org/dokuwiki/

2018/10/26 16:39

84/147

PINES Circulation Policies and Procedures Manual

Checking Out Items
Basic Checkout Procedure
A normal checkout session would proceed as follows:
1.
2.
3.
4.

Staﬀ member opens the Check Out screen (Circulation > Check Out).
Patron presents his/her library card (see: Library Card Required for Circulation).
Staﬀ member scans card to retrieve account.
Staﬀ member determines if patron is in good standing (i.e., not blocked, barred, inactive,
exceeding ﬁne limits).
5. Staﬀ member scans barcodes of items presented for checkout.
6. Staﬀ member clicks the “Done” button to prompt printing of checkout receipt.
7. Staﬀ member should verbally inform patron of due dates. (It is good practice to also inform patron
of due dates on any items already checked out on the account and to inform the patron of any
ﬁnes owed.)

Circulation Limits
In most cases, a maximum of 50 items may be charged simultaneously on a PINES card [1999.05],
[2002.12]. Some types of accounts, such as Restricted, and lower limits. See User Permission Groups for
more information on diﬀerent patron account types.
Materials circulate for varying periods of time; see the PINES Circulation Matrix for details on circulation
rules.
Audio-visual materials (DVDs, games, etc.) are limited to 15 per patron at any given time [2013.05]. This
policy supersedes any local limits that previously been used.

Proxy Borrowing
Any user may present another user’s card to check out materials. Library staﬀ should remind all patrons
at the time a card is issued that they are responsible for all items checked out on that card, and that lost
cards should be promptly reported. (See: Lost / Stolen Cards) PINES libraries also have the ability to
check out items on hold to an authorized proxy user (often husband or wife), as opposed to the user who
originated the hold, while maintaining the integrity of the holds queue.
Policies regarding Proxy Borrowing and procedures for administering this feature are at the discretion of
the individual library systems [2001.11]. The authorized proxy is not required to present the originator’s
card, but the authorization for proxy permission should be noted in the Alert Message ﬁeld. Because all
library records are conﬁdential in nature, PINES library staﬀ must be aware that authorization of the
originating user (the person placing the hold) is required for proxy checkout for all persons over 18 years
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of age.
Materials placed on hold by juveniles, as with any and all parts of the juvenile’s patron record, are
accessible and may be checked out by parents or legal guardians without prior authorization.

Checking Out Non-Cataloged Items
Many libraries do not have bibliographic records for paperback books, circulating magazines, or
equipment. The non-cataloged circulation function should be used to record a count of these items.
1.
2.
3.
4.
5.

Retrieve the patron account as you would for a normal checkout.
Click on Barcode to pull down a list of non-cataloged item types.
Select the appropriate type of non-cataloged item.
Enter the number of items.
Click Submit.

These items will be checked out on the patron’s account and will be given a due date, but will accrue no
ﬁnes. The patron account will show the non-cataloged items as checked out on the patron’s account until
the due date has passed and then will be automatically removed from the patron's account. Noncataloged item types may be conﬁgured separately for each library system by the designated
LocalAdmin.

Pre-Cats
With the exception of items that are intentionally non-cataloged (see above), all items borrowed by
patrons should have a barcode and be checked out through Evergreen. If an item is brought to checkout
without a barcode or if the barcode on an item is no longer in the database, it should be added/re-added
to the database on the spot, using the pre-cataloged item function to allow its circulation. For nonbarcoded items, staﬀ should apply a spare barcode to the item and scan it. Assigning ad hoc/temporary
or shortened barcodes is not recommended, as this can cause other items in other libraries to
accidentally be scanned. The following screen will appear:
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When this message appears when scanning a barcoded item, staﬀ should ﬁrst attempt to re-scan the
item. Many pre-cats are created from mis-scans, which causes problems with tracking and cleanup.
When it is determined that the item’s barcode is not in the database, ﬁll out the form.
When the item is returned, it must be forwarded to the Cataloging Department for full entry into the
database. Brief records should not remain in the system for more than one circulation. PINES member
libraries will be asked to periodically clean up brief records by deleting them or creating full records
[2002.05].
Complete Step-by-Step Instructions for Handling Pre-Cats

Cataloged Items Without Barcodes
If a cataloged item has lost its barcode, staﬀ should apply a new barcode to it before checking it out.
1.
2.
3.
4.
5.

Identify the old barcode number by searching the catalog.
In Evergreen click Circulation > Replace Barcode.
Enter the original barcode and the new barcode.
Click Submit.
Return to the patron account and check out as normal.
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Renewing Items
Most items can be renewed twice (see the PINES Circulation Matrix for exceptions). After items have been
renewed the maximum number of times, they must be returned and made available for all library
patrons. Certain categories of materials are not eligible for renewal. If a hold request has been placed on
an item, it may not be renewed. Selected staﬀ will have the authority to force the renewal in special
circumstances.
To accomplish a renewal, the patron must present his/her PINES card or read his/her PINES barcode
number to staﬀ over the phone. Staﬀ is encouraged to ask for a second item of identiﬁcation, such as
address or telephone number, to verify the identity of the caller. Items will not be renewed with name
only. Patrons may also renew their checked out items via the My Account feature of the OPAC. When an
item is in hand, no library card is required in order to renew the item.
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Checking In Items
Basic Check-In Procedure
1. Open the Checkin Items page (Circulation > Check In).
2. Scan each item's barcode.
When checking in materials, it is crucial to watch the screen as each barcode is scanned to be sure the
scan is registering and to be aware of on-screen messages and directions. Messages directing the staﬀ
member to send items to another location or library, or directions for items on hold are visually displayed
on the screen at check-in, and audible alerts will assist the operator in noticing important messages.

Back-dating Checkins
Staﬀ may change the date for the check-in by altering the Eﬀective Date ﬁeld for purposes of checking in
items from the bookdrop ﬁrst thing in the morning using a previous day's date, or in other circumstances
in which the check-in date needs to be changed. Set the desired check-in date, and check in items
normally. Reset the eﬀective date to the current day once back-dated checkins are complete.

Checking In Items That Need To Go To Another Library
If the item that is checked in needs to go to be routed to another library (either to fulﬁll a hold request at
another library or to return to its owning library), check it in as normal. The system will automatically
change its status to “In Transit” and a pop-up message will appear that will allow you to print a Transit
Slip that should be included with the item when sent to its destination.
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Checking In Items That Will Fill Hold Requests
If the item being checked in is needed to ﬁll a hold request at your library, check it in as normal. A pop-up
will appear that will prompt you to print a hold slip that should be attached to the item.

The item's status is automatically changed to “On holds shelf” and automated notices to the patron are
triggered (see: Automated Notiﬁcations). If the patron has opted to be notiﬁed by telephone, the
telephone number will appear on the hold slip so that staﬀ may call.

Checking in Pre-Cats
When pre-cataloged items (see: Pre-Cats) are checked in, the item status is automatically changed to
Cataloging and an alert message appears. Route the item to the cataloging department for full entry into
the database.
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Checkin Modiﬁers
Evergreen includes various options for altering how items are checked in for special circumstances (for
example, during amnesty periods). These options are selected through the Checkin Modiﬁers button on
the Checkin Items page.

Ignore Pre-cataloged Items: When checked, an “Ignore Pre-cataloged Items” message will
appear at the top of the screen and any pre-cataloged items will not appear in the checked-in list.
Not normally used.
Suppress Holds and Transits: When checked, a “Suppress Holds and Transits” message will
appear at the top of the screen and holds or transits will not be triggered by check in. Not normally
used.
Amnesty Mode/Forgive Fines: See below.
Auto-Print Hold and Transit Slips: This should be checked for most users in most situations.
Clear Holds Shelf: When checked, a “Clear Holds Shelf” message will appear at the top of the
screen. This checkin modiﬁer is used when removing items from the holds shelf that have not been
picked up by patrons. It will clear the item's “On hold shelf” status and allow it to be routed to its
next destination.
Each setting is unchecked by default, but the preferred setting is retained by the staﬀ client once
selected.

Amnesty Mode
On certain occasions, a library may set an 'amnesty' period to forgive ﬁnes on books returned during a
speciﬁed time period. In order to save time manually forgiving these ﬁnes, you may use the Amnesty
Mode option during the checkin process.
1. In the Evergreen Staﬀ Client, click Circulation > Check In Items.
2. On the bottom-right corner of the screen, click Checkin Modiﬁers > Amnesty Mode.
3. Check books in (you will see messages indicating if overdue ﬁnes have been removed from the
items).
4. Remember to uncheck Checkin Modiﬁers > Amnesty Mode when you wish to return to normal
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checkin.
When you check in items in while Amnesty Mode is turned on, the ﬁnes are voided (not forgiven) so they
will no longer show up on the patron accounts. If you need to ﬁnd out how many ﬁnes were voided during
this time period, you will need to run a report. (Please submit a Help Desk ticket if you require
assistance.)

Other Checkin Options
Print Receipt: Prints a receipt of the items listed on screen that have been checked in. (Use this
option if a patron requests a receipt of the items they have returned.)
Trim List: This option limits the list of items on screen to 20 rows, regardless of how many
barcodes are input. Not normally used.
Strict Barcode: If checked, the barcode ﬁeld will only accept 13-digit Codabar barcodes. Barcodes
in any format, even if legitimate, will not be processed.
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Item Statuses and Actions
Available
The item is on the shelf and available for check out.

Checked Out
The item is checked out to a patron. This status does not indicate whether or not the item is overdue.

Claims Returned Items
Claims Returned is used when both a library system and a patron are unable to agree on the location of
the disputed item thus creating a 'draw' or 'amnesty' for the item [2010.02]. If a user claims to have
returned materials that still show as checked out, the material may be marked with a Claims Returned
date. Overdue ﬁnes stop accruing as of the date entered in the Claims Returned ﬁeld.
A user may have up to 5 Claims Returned items on his/her record, after which no more items for that
user can be marked Claims Returned. If Claims Returned items are found, the Claims Returned counter
on the patron’s account information screen may be manually changed at the discretion of the owning
library system.
A Claims Returned item can be declared Lost by the owning library if it is not found after 45 days
[1999.10].
More Information about Claims Returned

Damaged Items
Damaged Items Policy
When an item is marked Damaged, it is hidden from the public catalog and will not be targeted for holds.
The Damaged item status may be used for items that are damaged beyond repair and will need to be
discarded, or for items that will be returned to the collection after repairs. The Damaged item status may
be used regardless of whether or not a patron will be billed for damages.
Only the library that owns an item should assess whether or not a patron should be billed for damages to
that item or not. The owning library may choose to bill the entire cost of the item plus a processing fee if
an item is damaged by the patron beyond repair, or may choose to bill a partial amount (for example,
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when there is repairable damage such as a minimally torn cover), or may choose to mark the item
damaged without billing the patron for it (for example, when there is damage caused by normal wear and
tear).
Libraries may choose to assess a processing fee of up to $10 per item for item damage on their own
items (this is set in the Library Settings Editor). If the damage is assessed after the item has been
checked in, a damaged bill may be added to the patron account manually.
Marking an item Damaged will not void overdue charges. If the patron is being billed the full price of an
item, the library may choose to manually void overdues.
See Payment Retention and Reimbursal regarding payments on Damaged items that are accepted by a
non-owning library.

Damaged Items Instructions
1.
2.
3.
4.
5.

To mark an item Damaged, open it in the Item Status/Details screen.
Click the Actions button.
Select Mark > Item as Damaged.
You will be alerted that the item will be marked Damaged. Click Submit.
If the item is currently checked out or contains information about the last patron that had it
checked out, a second popup will appear prompting you to choose whether to bill the patron for the
item or not. Your options will be to bill the full amount plus processing fee (this is the amount that
appears by default), to bill a diﬀerent amount (simply type in a diﬀerent amount), or not to charge
(click on the No Charge option).
6. Enter a note describing the type of damage.
7. Once you have made your selection, click Submit.

If the damaged item belongs to another library, you may mark it damaged with No Charge so that it will
PINES Documentation - https://pines.georgialibraries.org/dokuwiki/

2018/10/26 16:39

95/147

PINES Circulation Policies and Procedures Manual

return to its owning library and cannot be captured by a hold. If you do so, be sure to put a note on the
physical item explaining that you have marked it damaged but have not charged for it so that it will be
routed to the appropriate department at the owning library. The owning library may then go through the
steps to mark it damaged a second time, and choose the fee they wish to apply.

In Process
A new item has been purchased by a library but is not yet available for checkout.

In Transit
The item is being shipped from one library location to another. This status is automatically assigned by
the system. When an item arrives at its destination, a library staﬀ member checks it in, which removes it
from the In Transit status. If an item is in the In Transit status but does not arrive and cannot be located
at either the sending or receiving library, the status can be manually changed to Missing.
See also: Items in Transit

Long Overdue Items
Items that are overdue for longer than 180 days are automatically changed to a status of LONG
OVERDUE (unless the patron has been ﬂagged for collections). The price of the item, plus an optional
processing fee of up to $10 (set per library in the Library Settings Editor), is applied to the patron’s card.
Overdue ﬁnes on the item are automatically voided.
See Payment Retention and Reimbursal regarding payments on Long Overdue Items that are accepted
by a non-owning library.
If the patron ﬁnds the item and returns it within 6 months (180 days) of payment, the system will void
the item price and re-apply the overdue ﬁnes that had been previously voided. The system will not void
processing fees.
Historical Note: The PINES Executive Committee agreed upon a Long Overdue policy in May of 2006
[2006.05], but the system was not capable of automating it at the time. Implementation of this feature
occurred October 2014 and eligible items for the previous three years were marked Long Overdue.
Long Overdue Items Report
Shared Folders > Templates > ddale > Helpdesk Request > Collection Maintenance > Lost or Long
Overdue and Paid Item List
Payment for Long Overdue Items
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If a Long Overdue item is paid for at a diﬀerent library than the owning library, the payment amount may
be kept by the payment library unless the owning library sends an invoice for reimbursal within 90 days.
See Also:
Staﬀ Workﬂows for Long Overdue Processing
How Long Overdue Processing Works

Lost Items
A patron may inform staﬀ that an item is LOST. Staﬀ should mark the item LOST in Evergreen to create a
bill for the lost item. The price of the item, plus an optional processing fee of up to $10 (set per library in
the Library Settings Editor), will be assessed to the patron’s card. Overdue ﬁnes on the item will be
automatically voided when marking an item lost [2002.09]. Lost items may be paid for at any PINES
library.
See Payment Retention and Reimbursal regarding payments on Lost Items that are accepted by a nonowning library.
If an item has been marked lost that has not been paid for is returned within 180 days, Evergreen will
automatically void the item’s cost and reinstate any overdue ﬁnes that had previously been voided when
the item was marked lost. The system will not void processing fees.
Refunds on Lost and Long Overdue Items
If an item has been marked Lost or Long Overdue that has not been paid for is returned after 180 days,
Evergreen will not void the item's cost.
Evergreen will not void processing fees. If a library chooses to forgive a processing fee for one of their
own items, staﬀ must do it manually. Libraries must not forgive or void processing fees on items owned
by other libraries.
Evergreen will only automatically void and restore ﬁnes associated with the circulation that resulted in
the lost item. The system does not void/restore overdue ﬁnes related to other circulation transactions on
an item.
“Found” materials may be returned to any PINES library but routed to the owning library, with the
understanding that the owning library will be the ﬁnal authority on whether the material is in acceptable
condition for return. When appropriate, the owning library will issue a refund check to the patron via U. S.
Mail. The refund check will be payable to the library cardholder on whose record the materials were
circulated [1999.10].

Missing
Missing is a status assigned to items which show as available in the library catalog, but which are not
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found on the shelf. When an item is not found on the shelf, a staﬀ member should manually mark the
item Missing in Evergreen using the Item Status editor. The library should then run a regular report of
items in Missing status to try to locate them, and then delete them as they see ﬁt.

On Holds Shelf
The item has been placed on a library's Holds Shelf and is ready for pick up by the patron it is on hold for
at the patron's desired pickup location.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation
Permanent link:
https://pines.georgialibraries.org/dokuwiki/doku.php?id=circ:circulation:lost
Last update: 2018/10/11 15:15

PINES Documentation - https://pines.georgialibraries.org/dokuwiki/

2018/10/26 16:39

98/147

PINES Circulation Policies and Procedures Manual

Items in Transit
When an item is routed from a library location to another, it is placed automatically in “Transit” status.
When the item arrives at its destination, it should be checked in. If the item is returned and does not
have any holds on it, it will switch to “Reshelving” status. After one day (24 hours), it will automatically
switch to “Available” status. If the item is on hold for someone, the system will print a hold slip.
If the item arrives at its destination but is not checked in properly, it will remain in Transit status even
though it might be reshelved. To anyone viewing the catalog, it will look like the item is not available and
it will delay holds on the title.
It is recommended that each library check their transit lists on a regular basis (monthly or weekly) to
catch any items that have been routed to their location, but not checked in.

Evergreen's Transit List Interface
1. In the Evergreen Staﬀ Client, click on Administration > Local Administration > Transit List.
2. Select whether you want to view Transits to or Transits From a particular library.
3. Select a date range. The screen will refresh with a list below.
To search for items that have been in transit for a long time:
1. Use the column picker to add the Call Number Label column and then click the column header to
sort by call number.
You may wish to display more rows at once.
You may wish to remove some columns
Use the browsers File > Print functionality to print the list. (You may be able to get the
information you need using the Print Transits button, but that is still under review as of 2.12.)
2. Check the library for each item.
If you ﬁnd an item, scan it into the Checkin screen to update its status.
If you are unable to ﬁnd an item, mark it Missing.

Transit Quick Reports
You may also retrieve this information through reports if you wish.
Quick Reports > Quick Report Templates > Items > Transits: My Library's Items In Transit
Quick Reports > Quick Report Templates > Items > Transits: Sent from My Library
Quick Reports > Quick Report Templates > Items > Transits: Sent to My Library
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PINES Circulation Matrix
Fine Levels
Every item has an attribute called “Fine Level” that determines the level of recurring ﬁne with which the
item circulates, within a pre-determined range of levels. By default, copies are set to “normal”. If a copy
has been manually altered in the copy editor to “high” or “low”, the ﬁne level will change according to
the table below. For example, if a given item circulates at $.20/day (based on the circ modiﬁer, MARC,
etc.) and the item ﬂag is changed to have a “high” ﬁne_level, then it will circulate at $.50 / day.
The low/normal/high ﬁne level options are not enabled for all item types.

Duration Rules
Every item also has a “Loan Duration” attribute, which aﬀects the length of time an item circulates with
the options of “short”, “normal” (the default setting), and “long”. Loan duration options are not enabled
for all item types.

Circulation Matrix
Use of circulation modiﬁers for speciﬁc item types should be in compliance with PINES policies.
When an item has a circulation modiﬁer, that modiﬁer takes precedence over the MARC item type
when determining circulation rules.
PINES is transiting away from using MARC item Type for circulation rules. All new items should be
assigned the appropriate circulation modiﬁer.
* Click here for Circulation Modiﬁer list and deﬁnitions.

Circ Modiﬁer
art
audiobook
av
bestseller
book
book-ﬀ
cd
dvd
dvd-mid

Recurring
Recurring
Recurring
Short
Fine
Fine
Fine (Low)
Duration
(Default)
(High)
.20
.20
.50
.50
.20
.50
.20
no ﬁnes
.20
.50
.50
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Normal
Duration
3 months
14 days
7 days
7 days
14 days
14 days
14 days
7 days
7 days

Long
Renewal
Duration
Count
1
2
2
2
2
2
2
0
2
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Recurring
Recurring
Recurring
Short
Fine
Fine
Fine (Low)
Duration
(Default)
(High)
dvd-long
.20
e-book
.50
e-device
10.00
5.00
50.00
1 day
equipment
10.00
5.00
50.00
1 day
equipment-local
10.00
5.00
50.00
1 day
high demand
$1.00
7 days
kit
.20
5.00
50.00
localpass
3.00
1.00
5.00
3 days
magazine
map
.50
microform
.20
music
.20
realia-0
10.00
3.00
25.00
3 days
realia-1
10.00
3.00
25.00
3 days
realia-2
10.00
3.00
25.00
3 days
record
.20
software
1.00
.20
5.00
3 days
statepass
3.00
talking book
0
toy
.20
video
.50
video-mid
.50
video-long
.20
videogame
1.00
.20
5.00
3 days
Circ Modiﬁer

Normal
Duration

Long
Renewal
Duration
Count

14 days
3 days
7 days
3 days
3 days

14 days
7 days
7 days

14 days
7 days

14 days

3 days
14 days
14 days
7 days
7 days
7 days
14 days
7 days
7 days
unlimited
14 days
7 days
7 days
14 days
7 days

14 days
14 days
14 days
14 days

14 days

2
1
0
0
0
0
2
1
2
1
2
2
0
1
2
2
2
1
0
2
0
2
2
2

Circulation Matrix: MARC Types
MARC Item Type
a - Language Material
c- Notated Music
d - Manuscript Notated
Music
e - Cartographic
Material
f - Manuscript
Cartographic Material
g - Projected Medium
i - Nonmusical Sound
Recording

Recurring
Fine
.20
.20

Recurring Recurring
Short
Normal
Long Renewal
Fine
Fine
Duration Duration Duration Count
(Low)
(High)
14 days
2
14 days
2

.20

14 days

2

.50

7 days

2

.50

3 days

1

.50

7 days

0

.20

14 days

2
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Recurring
Fine

j - Musical Sound
Recording
k - Two-dimensional
Nonprojectable Graphic
m - Computer File
o - Kit
p - Mixed Materials
r -Three-dimensional
artifact or naturally
occurring object
t - Manuscript Language
Material
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Recurring Recurring
Short
Normal
Long Renewal
Fine
Fine
Duration Duration Duration Count
(Low)
(High)

.20

14 days

2

.20

3 months

0

.20
.20
.20

14 days
14 days
14 days

2
2
2

.20

14 days

2

.20

14 days

2

Circulation Exceptions
Item Circ
System
STATELIB
STATELIB

Circ Mod,
Recurring Fine
Etc.
book
default
ref ﬂag
based on circset
mod

Short
Duration
35 days

Normal
Duration
35 days

Long
Duration
35 days

Renewal
Count
1

14 days

14 days

14 days

2

NOTE: There should be no STATELIB-L items with the reference ﬂag set, but the circulation policy exists
to catch ones that do. STATELIB-L A/V items are holdable by any patron in PINES.

Age Protection
See: Age Protection

Holds
Only items with the 'book' or 'book-ﬀ' circulation modiﬁers are holdable throughout the consortium. Items
with all other circulation modiﬁers are holdable only within their own systems.

Max Fine Levels
See Max Fines vs. Max Bills
Systems using the maximum max-ﬁne level of $100:
DTRL
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Systems using the medium max-ﬁne level of $10.00:
ARL CHRL DCPL ECGR FRRLS HCLS HOU* SJRLS NCLS OCRL OHOOP OKRL PMRLS STRL TRRL
All other systems use the $5.00 max-ﬁne level

Special User Groups
Users in the following groups (or sub-groups) accrue no late ﬁnes on circulations: Staﬀ, Trustee,
Institution, GLASS, Homebound
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PINES Circulation Modiﬁer List
art
audiobook
av
bestseller
book
book-ﬀ
cd
dvd
dvd-mid
dvd-long
e-book
e-device
equipment
equipment-local
high demand
kit
localpass
magazine

map
microform
music
realia-0
realia-1
realia-2
record
software
statepass
talking book
toy
video
video-mid
video-long
videogame

PINES Circulation Modiﬁer Deﬁnitions
See PINES Circulation Matrix for circulation rules
Circulation
Modiﬁer

Description

art

Circulating artwork such as prints, paintings or statuary.
Not holdable outside owning library system.

audiobook

av

bestseller

Nonmusical sound recordings. Can be audiocassettes,
compact discs, MP3 players or other nonprint, physical,
media designed to be played back on an audio device. A
007 ﬁeld should be included in the MARC record to deﬁne
speciﬁc type. Not holdable outside owning library system.
Reserved for categories of audio-visual media not deﬁned
in other modiﬁers. This modiﬁer will typically be older
media such as ﬁlmstrips. Do not use if another modiﬁer is
more appropriate. Not holdable outside owning library
system.
High demand book. Modiﬁer should be changed to book
when demand lessens, or after owned by library for
speciﬁc period of time. Items with this modiﬁer can be
nonholdable for owning library. Not holdable outside
owning library system.
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MARC Type Correlation
(if applicable)
k: Two-dimensional
nonprojectable graphic; r:
Three-dimensional artifact
or naturally occurring
object.
i: Nonmusical sound
recording.

g: Projected medium; i:
Nonmusical sound
recording; j: Musical
sound recording.
a: Language material; t:
Manuscript language
material.
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Circulation
Modiﬁer
book

book-ﬀ

cd

dvd

dvd-mid

dvd-long

e-book

e-device

equipment

equipment-local
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MARC Type Correlation
(if applicable)

Physical print monographs and serials, except for print
a: Language material; t:
magazines or journals. Can include atlases, pamphlets, or
Manuscript language
technical reports as well as books. Holdable outside
material.
owning library sysem; age protection rules can apply.
Physical print monographs and serials, except for print
magazines or journals. Can include atlases, pamphlets, or a: Language material; t:
technical reports as well as books. Does not accrue
Manuscript language
ﬁnes. Holdable outside owning library system; age
material.
protection rules can apply.
Musical or non-musical sound recordings or software on
j: Musical sound
compact disc. A 007 ﬁeld should be included in the MARC
recording; m: Computer
record to deﬁne media format. Not holdable outside
ﬁle.
owning library system.
Projected media on DVD (Digital Versatile Disc or Digital
Video Disc). A 007 ﬁeld should be included in the MARC
record to deﬁne media format. Items with this circulation g: Projected medium.
modiﬁer have ﬁnes of .50/day, circulate for 7 days and are
not renewable. Not holdable outside owning library system.
Projected media on DVD (Digital Versatile Disc or Digital
Video Disc). A 007 ﬁeld should be included in the MARC
record to deﬁne media format. Items with this circulation
g: Projected medium.
modiﬁer have ﬁnes of .50/day, circulate for 7 days and are
renewable twice. Not holdable outside owning library
system.
Projected media on DVD (Digital Versatile Disc or Digital
Video Disc). A 007 ﬁeld should be included in the MARC
record to deﬁne media format. Items with this circulation
g: Projected medium.
modiﬁer have ﬁnes of .20/day, circulate for 14 days and
are renewable twice. Not holdable outside owning library
system.
A print or sound recording available only through digital
download from an online source. Not holdable outside
Type depends on content.
owning library system.
Any device used to read or playback downloadable media, r : Three-dimensional
whether print, sound or visual. Not holdable outside
artifact or naturally
owning library system.
occurring object.
Physical resources such as projectors, cameras,
magnifying glasses, screens, etc. made available for
r: Three-dimensional
circulation. Does not include e-readers or other devices
artifact or naturally
more properly categorized elsewhere. Not holdable outside occurring object.
owning library system.
Physical resources such as projectors, cameras,
magnifying glasses, screens, etc. made available for
r: Three-dimensional
circulation. May include e-readers or other devices more
artifact or naturally
properly categorized elsewhere if holds need to be
occurring object.
restricted to the branch library. Not holdable outside
owning library (branch only holds).
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record

realia

software

statepass
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Description
Items with this modiﬁer can be any media, format, or
audience. Used to support a program where patrons can
check out high demand items if they are on the collection
shelf when the patron is in the library. Voluntary use;
libraries can name program/collection as they wish; some
libraries call their collection Lucky Day. Items with this
circulation modiﬁer have a circulation period of 7 days;
$1.00/day ﬁne, OPAC invisible and should be set as
nonholdable (if library uses separate shelving/copy
location, it should be set up as not holdable and OPAC
invisible. Otherwise, items with the circ modiﬁer should
have attributes set to not holdable and OPAC invisible).
Mixed-formats or multiple components that circulate as a
unit under one barcode. May not be considered a kit for
cataloging purposes (record may not use Type o since a
component might be considered primary). Not holdable
outside owning library system.
A ticket or other physical pass to a local venue or
attraction. Generally cataloged as Type k – twodimensional nonprojectable graphic. Not holdable outside
owning library system.
Individual or bound issues of a periodical. Not holdable
outside owning library system.
Physical map and other cartographic material, not
including atlases. (Use circ modiﬁer book for atlas). Not
holdable outside owning library system.
Forms containing micro-reproductions. Includes microﬁlm
reels and microﬁche cards. These can be cataloged as
monographs, serials or other bibliographic Types. Not
holdable outside owning library system.

MARC Type Correlation
(if applicable)

Type depends on content.

Type depends on content.

k: Two-dimensional
nonprojectable graphic.
a: Language material.
e: Cartographic material;
f: Manuscript cartographic
material.
Type depends on content.

j: Musical sound
Either print music scores or music sound recordings in any
recording; d: Manuscript
format. Not holdable outside owning library system.
notated music.
Music sound recording in vinyl record format. Not holdable j: Musical sound
outside owning library system.
recording.
Any three-dimensional artifact or naturally occurring object
r: Three-dimensional
not appropriate for other circulation modiﬁers. Maybe
artifact or naturally
games, toys, musical instruments, etc. Not holdable
occurring object.
outside owning library system.
Programs used to control the functioning and operation of
a computer or other device. Can be any format. Not
m: Computer ﬁle.
holdable outside owning library system.
Any physical pass or ticket issued for a venue or attraction
that is a part of a state-wide promotion. Maybe be
k: Two-dimensional
governed by contractual obligations requiring speciﬁc
nonprojectable graphic.
circulation rules. May be a serial or a kit. Not holdable
outside owning library system.
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MARC Type Correlation
(if applicable)
Audio recordings speciﬁcally formatted for use of the
i: Nonmusical sound
visually impaired.
recording.
Realia toys, games or other three-dimensional object for
r: Three-dimensional
play or instruction using play. Not holdable outside owning artifact or naturally
library system.
occurring object.
Visual material in videocassette format. Circulation rules
are.50/day, 7 days duration with 0 renewals. Not holdable g: Projected medium.
outside owning library system.
Visual material in videocassette format. Circulation rules
are .50/day, 7 days duration with 2 renewals. Not holdable g: Projected medium.
outside owning library system.
Visual material in videocassette format. Circulation rules
are .20/day, 14 days duration with 2 renewals. Not
g: Projected medium.
holdable outside owning library system.
An electronic or computerized game played by
manipulating images on a video display or television
m: Computer ﬁle.
screen. Not holdable outside owning library system.
Description
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Collection Maintenance Reports
The following reports may assist libraries with maintaining their local collections.

Claims Returned
Libraries may mark Claims Returned items Lost after 45 days from the due date. For assistance
identifying these items, use:
Quick Reports > Quick Report Templates > Items > List of Items Marked Claims Returned
See also: Claims Returned Items

Holds
Uncaptured Holds:
To identify holds that patrons have placed but that have not been found on the shelves after a certain
length of time, use:
Quick Reports > Quick Report Templates > Holds > Unﬁlled Holds (Not Captured)
Unﬁlled Holds:
To identify holds that were found for patrons, but that the patrons did not pick up, use:
Quick Reports > Quick Report Templates > Holds > Unﬁlled Holds (Captured but Not Fulﬁlled)
Expired Holds:
To identify expired holds that are currently on your holds shelf, see: Clear Holds Shelf

Inventory
See: Inventory Process

Item Status Report
Get lists of items of a particular status (Missing, In Process, etc.) in order to do shelf checks.
Quick Reports > Quick Report Templates > Items > List of Items by Status
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Long Overdue Items
See: Long Overdues

Pre-Cats
Pre-cat (pre-cataloged item) records are temporary records used for Interlibrary Loan or to allow
checkouts of items that have barcodes but no record in the catalog. Pre-cat records should be used for
temporary purposes only and should be corrected (or deleted, in the case of ILL) when the item is
returned to the library.
Quick Reports > Quick Reports Templates > Items > Pre-Cat List
See also: Instructions for managing Pre-Cats

Transit Reports
You can retrieve transit reports through a built-in staﬀ client function or through a report, depending on
your needs.
See: Clear Items In Transit

Weeding Report
Quick Reports > Quick Report Templates > Items > Basic Weeding List

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation
Permanent link:
https://pines.georgialibraries.org/dokuwiki/doku.php?id=circ:circulation:maintenance-reports
Last update: 2018/10/11 15:15

PINES Documentation - https://pines.georgialibraries.org/dokuwiki/

2018/10/26 16:39

110/147

PINES Circulation Policies and Procedures Manual

Oﬄine Circulation
There are times when the full PINES functionality is unavailable – during a PINES upgrade, or unexpected
outage, when a libraries internet or local network service goes down, or when doing outreach in an area
without an available internet connection.
Rather than shutting down all circulation operations or trying to track checkouts on paper, you can use
the Evergreen Oﬄine Interface to process checkouts. There are several advantages over the paper
method, 1) the barcode scanner can be used to reduce typing errors and save time, and 2) a receipt will
print after each checkout.
This interface stores a local transactions ﬁle that contains information about all of the circulation actions
made while oﬄine. When the computer can reconnect to the PINES server, that oﬄine ﬁle must be
uploaded and processed as soon as possible.

Set Up
Prior to using the web-based oﬄine interface for the ﬁrst time, you will need to:
1. Bookmark the oﬄine circulation page in your browser:
https://gapines.org/eg/staﬀ/oﬄine-interface
2. If you are using Hatch, your Oﬄine printing settings will need to be set up.
Hatch Instructions

PINES Documentation - https://pines.georgialibraries.org/dokuwiki/

2018/10/26 16:39

111/147

PINES Circulation Policies and Procedures Manual

Using the Oﬄine Interface
Start
1. Open the Oﬄine Interface: https://gapines.org/eg/staﬀ/oﬄine-interface
2. Verify that the Workstation and Working Location are correct.
Checkout

1. Click on the Checkout tab.
2. Set the Due Date either by using the calendar OR by changing the Oﬀset dropdown to “Today + 14
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Days” (or whatever time period is appropriate for the item type).
3. Check the Print Receipt box.
4. Scan the patron barcode.
5. Scan an item barcode.
Or, circulate honor-system items by using the Non-cataloged Type option and the number
counter.
6. Click Checkout after each item. This will display the item to the right.
7. When all items for the patron have been checked out, click the Save Transactions button at the top
of the page.
Renew
The oﬄine interface does not provide information about what items a patron already has checked out,
how many times the patron has already renewed their items, or if the items they are renewing are on
hold for another patron. So, if a library chooses to renew items through this interface, the system will
provide a list of errors when the oﬄine ﬁle is uploaded that staﬀ will need to follow up on.
1. Click on the Renew tab.
2. Set the Due Date either by using the calendar OR by changing the Oﬀset dropdown to “Today + 14
Days” (or whatever time period is appropriate for the item type).
3. Check the Print Receipt box.
4. Scan the patron barcode.
5. Scan an item barcode.
6. Click Renew after each item. This will display the item to the right.
7. When all items for the patron have been renewed, click the Save Transactions button at the top of
the page.
In-house Use
1.
2.
3.
4.

Click on the In-house Use tab. (Do not check the Print Receipt box.)
Scan an item barcode.
Click Record Use after each item. This will display the item to the right.
When all in-house use items have been scanned, click the Save Transactions button at the top of
the page.

Checkin
The Checkin function should not be used in PINES because it will not be able to alert staﬀ if the item
has any holds, transits, routing alerts, or any other type of statuses that require staﬀ attention.
Register Patron
The oﬄine interface has no way of knowing whether or not the patron that is applying for a library card
already has a card in the system. If your library chooses to register patrons using the oﬄine interface,
you will need to be very diligent about checking each new account for older duplicate cards after you
reconnect to the server. If you ﬁnd duplicates, create a help desk ticket for each one so that they may be
merged (see: Multiple Patron Accounts / Patron Record Merging).
1. Click the Register Patron tab.
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Verify that the screen is showing All Fields.
Complete the registration form as you normally would (see: Creating New Patron Accounts).
Click the Save button.
Click the Save Transactions button.

Uploading the Oﬄine Transactions

Once you are able to reconnect to the PINES server and log into Evergreen, you will need to upload and
process all of the activities that were recorded while you were oﬄine. (This needs to be repeated for each
workstation that used the oﬄine interface.)

1.
2.
3.
4.
5.
6.
7.

Log in and go to Circulation > Oﬄine Circulation.
Click on the Session Management tab.
Click on the Oﬄine Sessions tab.
Click the Create Session button and enter a name for that session (ex: Upgrade CircComputer1).
Select / highlight the new session you created.
Click the Upload button.
After uploading, click the Process button (the processing step must be done by a staﬀ member
logged in as a LibraryManager or LocalAdmin).
8. When processing is complete, scroll down to the very bottom of the screen to see the Exceptions
List.
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9. Go through each item in the exception list and investigate and correct the problem. The Item and
Patron buttons to the right of each row are clickable and will open in a new browser tab for
convenience.

Deﬁnitions of Exceptions
ACTOR_CARD_NOT_FOUND
Indicates the patron's library barcode was mis-scanned/mis-typed. Attempt to correct it if you can
determine the error, but that may not be possible.
ASSET_COPY_NOT_FOUND
Indicates the item barcode was mis-scanned/mis-typed. Attempt to correct it if you can determine the
error, but that may not be possible.
CIRC_CLAIMS_RETURNED
Indicates a book previously marked as claimed returned was found and checked out. Check the current
patron to be sure it is checked out correctly, and check the item’s history to make sure any erroneous
messages or ﬁnes are removed from the prior patron's account.
COPY_IN_TRANSIT
Indicates a book was checked out that had been marked as in transit. Check the patron to make sure that
the book was checked out correctly to his or her account.
COPY_STATUS_LOST
Indicates a book previously marked as lost was found and checked in.
MAX_RENEWALS_REACHED
Since the patron already has the item in hand, you will need to go into the patron's account and either
override the extra renewal to allow it or change the due date to the new due date.
OPEN_CIRCULATION_ EXISTS
Indicates a book was checked out that had never been checked in. This is not usually an issue because
the book should usually appear on the patron's account correctly even though the error appears on this
list. However, you should look up the item's history to be sure that it is showing up correctly and no
longer indicates that it is checked out to the previous patron.
PATRON_ACCOUNT_EXPIRED:
If you are downloading the oﬄine patron list on a daily basis, and if the Circulation Staﬀ are paying
attention to the error messages that pop up while using the Standalone Client, you should rarely see this
error. On the occasions you do see it, go into the patron’s account and renew their card for a few days.
Make a note in the patron’s account to renew their card the next time they are in the library and check
out the items to that card. You may also wish to add a message to the Patron Message Center (see:
Alerts, Notes, and Messages) to alert them that they'll need to renew their card (see: Card Expiration and
Renewal) the next time they come into the library.
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Problems That May Not Generate Exceptions
Checking out an item with an incorrect borrowing time.
Attempting to re-check out an overdue book.
Checking out a reference book.
Checking out an item belonging to another library.
Checking out a book on hold for another patron.

Importing and Exporting Pending Transactions
If for some reason the workstation that was used for oﬄine circulation cannot be used to upload the
transactions ﬁle, that ﬁle can be exported and then imported into a diﬀerent workstation for uploading
and processing.
1. On the workstation that was used for oﬄine circulation:
Go to the Oﬄine Circulation interface.
Click on the Export Transactions button.
Save the ﬁle to a convenient location (do not change the name or formatting or add a ﬁle
extension).
2. On the workstation that is connected to PINES:
Log in and go to Circulation > Oﬄine Circulation.
Click on the Session Management tab.
Click on the Pending Transactions tab.
Click on the Import Transactions button.
Select the oﬄine ﬁle that you saved in step 1.
Go to the Oﬄine Sessions tab and upload and process as normal.

Viewing Oﬄine Transactions without Exporting
The easiest way to view oﬄine transactions before uploading them is to export them. However, if that is
not possible, you can view them via the browser's internal tools. (Clearing your browser's local storage
(cache) will erase the oﬄine transaction data, and you will no longer be able to access it.)
In Firefox:
1.
2.
3.
4.
5.
6.

Click on the Menu icon (three dashes) > Web Developer > Storage Inspector
Expand Indexed DB
Expand https://gapines.org
Expand oﬄine (default)
Click on oﬄineXact
You should be able to view the value for each oﬄine transaction that has not yet been uploaded.
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In Chrome:
1.
2.
3.
4.
5.
6.

Click on the Menu icon (three dots) > More Tools > Developer Tools
Switch to Application tab
Expand Indexed DB
Expand the oﬄine https://gapines.org section
Click on oﬄineXact
Expand each row to see the data.
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Holds
PINES patrons may place holds on books owned by any PINES library, as well as on certain additional
types of materials (such as audio-visual materials) within their own local library system. Items which are
placed on hold will be delivered via courier from the owning library to the patron's desired pickup library.
Materials will retain the same circulation period regardless of whether the patron is local or from another
PINES library. When thinking of intra-PINES lending, it is important to remember that a PINES patron is a
patron exactly like your local patron. Intra-PINES loans are not ILLs – they are simply circulations like any
other. The PINES Executive Committee has ruled that circulations between PINES libraries must be free of
charge to system libraries and to patrons [2008.09].
The vision of the PINES statewide library card included as a key component the ability for patrons to see
and borrow library materials from all participating public libraries in the state. Our goal is maximum
access for all patrons, while realistically addressing the logistics of moving materials around the state.
Member libraries have agreed that PINES membership would not relieve libraries of the responsibility for
purchasing the materials needed to meet the demands of local patrons.
Staﬀ must never give preference to one patron over another regarding holds. The PINES code of ethics
requires that all libraries respect the integrity of the hold queue, and share equitably.

Placing Holds
Patrons may place their own holds via the OPAC, and may select their pickup location and
notiﬁcation method. The software will refuse holds requests which do not conform to PINES policies.
Patrons may choose any pickup location for holds. Patrons may not place multiple holds on a single
title record, but staﬀ may place multiple holds on a single title record on behalf of the patron (e.g.,
for a book club) [2006.05].
Patrons whose PINES cards are expired will not be allowed to place holds until the card privilege is
renewed.
Most patrons may place 50 holds at any given time on their account [2006.11]. Certain user
categories are restricted to diﬀerent number of holds limits.
If a patron presents the on-hold item for checkout before it is retrieved for the requesting patron,
the in-house patron with item in hand receives preference; a circulation supervisor will override the
hold and check out the item to the in-house patron. The requesting patron will be next in line for
the item.
Hold requests expire after 6 months with the option for staﬀ or patron to make it an earlier or later
date [2008.02].

Pulling Holds
An automated process (the Holds Targeter) runs periodically throughout the day and identiﬁes copies of
items at PINES libraries that can fulﬁll holds.
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Each weekday (M-F) morning, each PINES library location will print a report (the Pull List) of items on their
shelves which have hold requests (Circulation > Pull List for Hold Requests). The items on this list should
be retrieved from the shelves and processed within 24 hours.
If an item should be on the shelf but cannot be found, mark the item Missing (Circulation > Item Status >
Scan Barcode > Actions > Mark Item as Missing). This will direct the Holds Targeter to look for a diﬀerent
copy of the item within PINES. It will also allow you to generate a report of missing items in your library.
If you receive an inappropriate holds request on your list (for an item type that is not eligible for intraPINES loans), contact the requesting library via e-mail or telephone and ask them to remove the hold.
Please DO NOT ignore such holds, as they will continue to appear on your list each day until they are
resolved.
Libraries may choose to pull and process holds more than once per day if desired, and may also choose
to pull and process holds on weekend days if desired.

Processing Holds
After pulling items from the shelves (or when receiving items routed to your location to fulﬁll a hold from
another location), scan them into the Checkin Interface (Circulation > Capture Holds).
If the item being scanned is on hold for a local patron, the system will print a Hold Slip that contains the
patron’s contact information. If the patron has chosen to be notiﬁed by email, an email will be
automatically generated within the hour and sent to the address on ﬁle. If the patron has chosen to be
notiﬁed by telephone, then staﬀ must call the patron. The item should then be placed on the Holds Shelf.
If the item being scanned is on hold for a patron of another location, the system will print a Transit Slip
and staﬀ will place the item in transit. Items should be appropriately packaged to protect them from
damage while in transit [2008.11]. All materials should be treated the same as each library would want
its own materials handled [2009.05].
Holds that are not processed within 24 hours will be re-targeted to another library if possible. For 5
days, the hold targeter will only select items within the pickup library. After 5 days, the hold may
be ﬁlled by any copy within PINES [2007.12]. Borrowed items should be promptly sent back to the
owning library or on to the next library to ﬁll a hold.
A database of PINES delivery addresses in mailing label format is provided to each library (see
Library Routing, Courier, and Contact Info); you can print out the addresses needed on demand. For
convenience, the Evergreen receipt templates for transit items can be conﬁgured to print the
library policy name and courier code for each item (see Print Templates). All items should be sent
out within 24 hours of receipt of the holds list.
Holds notices will be emailed within an hour of when the item is available for those patrons who
have email addresses in their user records and who have chosen to be notiﬁed by email. Each
library is responsible for contacting users who have chosen to be telephoned regarding available
holds. No paper notices will be mailed centrally.
Holds will also be captured in the normal course of checking in items. These holds should be
processed and routed within 24 hours.
PINES Documentation - https://pines.georgialibraries.org/dokuwiki/

2018/10/26 16:39

119/147

PINES Circulation Policies and Procedures Manual

The Holds Shelf
Each library may decide how long to keep its own items on the holds pickup shelf; however, items from
outside the local library system should be held on the holds shelf for a maximum of seven (7) open
business days [2009.05], then returned to the owning library or forwarded to the next person waiting in
line for a hold.

Clearing the Holds Shelf
Staﬀ should monitor the holds shelf and remove items that have not been picked up within the
designated amount of time or whose holds have been cancelled.
Identify the holds which should be placed back into circulation.
1. View the holds shelf (Circulation > Holds Shelf). The list you see should match the books that are
actually present on your holds shelf. (Sorting is not available in the 2.12 web client, but is targeted
to be available in the 3.0 web client.)
2. Determine which items should be pulled oﬀ of the holds shelf.
If you check the View Clearable Holds box, it will show you which items have been on the
holds shelf for more than 7 days.
The Available On column displays the date that the item was actually placed on the holds
shelf.
Each library system may determine how many days to allow their own items to remain on the
holds shelf. However, items belonging to a diﬀerent library system should not be held for
more than 7 days.
3. Scan the items in the Checkin interface using the ‘Clear Holds Shelf’ Checkin Modiﬁer (see Checkin
Modiﬁers).
If you have checked the View Clearable Holds box and you press the Clear These Holds
button, the current holds for the listed items are all cancelled at once, but their item status
will still read 'On holds shelf' until you check the items in. If you use this method, you do not
need to use the 'Clear Holds Shelf' Checkin Modiﬁer, you can just check the books in as
normal.
If you use the 'Clear Holds Shelf' Checkin Modiﬁer, be sure to disable the modiﬁer before
checking in other books. (On the Check In screen, press the Checkin Modiﬁers button on the
bottom-right of the screen and select Clear Holds Shelf to remove the checkmark.)

Checking in Returned Holds
When a patron returns an item that is owned by another library, the system will print out a transit slip
directing the staﬀ to return the item to the owning library (or to the next location waiting for a hold on
the item). Route these items to the appropriate location within 24 hours of their return.
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Suspending Holds
A hold can be placed on an item and then suspended (inactivated) until a later date by staﬀ or the
patron. The holds targeter will ignore these holds while they are inactive.
If an activation date is set, the system will automatically reactivate the hold on the set date. If not, the
hold will not reactivate until manually reactivated by the patron or by library staﬀ.

Changing the Pickup Location of a Hold
A staﬀ member or a patron may change the pickup library of a hold after the hold has been placed. Once
the pickup location has been changed, the item needs to be scanned on the checkin screen to place it in
transit to the correct pickup library.
A patron may change the pickup location of a hold by going to My Account > Holds, then clicking the
'Edit' link next to the title.
Staﬀ may change the pickup location of a hold from the Holds Shelf screen or from the Patron's Hold
screen (Actions > Edit Pickup Library).
If the hold has its pickup library changed while it is in transit to the original pickup library, when it arrives
and is scanned in, it will print a new transit slip to the new pickup library.
If the hold has its pickup library changed after it has already arrived at the original pickup library, the
Status on the Holds Shelf screen will say 'Wrong Shelf.' If staﬀ see the Wrong Shelf status, staﬀ should rescan the item on the check in screen in order to place it into transit to the new destination.

Holds Behind Circ Desk
A library may choose to have the holds shelf located in a staﬀ-only area or in a public area where patrons
can retrieve their own holds. Libraries that have public holds shelves can oﬀer patrons the ability to
request that their holds are placed in a private area. To make use of this feature, the library should set
the “Behind Desk Pickup Supported” option to “true” in the Library Settings Editor. This will display a
“Hold is behind Circ Desk” option on the patron information screen. Hold slips for these patrons will print
with the notation “PRIVATE HOLDS SHELF” and all other hold slips will print with the notation “PUBLIC
HOLDS SHELF” [2014.05].

Restricted Holds on Age-Protected Items and Audio-Visual
Materials
Audio-visual items and age-protected items are only available for holds by patrons registered to the
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owning library/region, and are only available for pickup within the item's owning system. [2007.02]

A-V Items and Other Restricted Items
Under normal circumstance, PINES does not allow intra-PINES loans on the following item categories:
Audiobooks
CDs
Deposit (monetary)
DVDs
Bestsellers
Equipment
Leased Materials
Microforms
New Books
Outreach
Reference
Reserve
Software
Toy
Videocassettes
Video Games
Items of these types may be placed on hold only within regional library systems. Leased items will be
treated the same as any other book with regards to holds [2006.11].
For other item types, a title-level hold will ﬁnd the ﬁrst available copy of the title in PINES to ﬁll the hold.
The Holds report will ﬁrst look for an available copy in the patron’s pickup library, then in the pickup
library’s system; if no copy is available, it will then select a copy from another PINES library.
The Executive Committee has approved a special reciprocal arrangement for Dougherty County Public
Library and Lee County Library regarding holds restrictions in all formats (except new items). Lee County
and Dougherty County patrons are allowed to place their own holds on either system’s restricted formats
with the exception of age-protected items. This exemption only aﬀects DCPL and LEE home library
patrons. [2007.12]

Holds
PINES patrons may place holds on books owned by any PINES library, as well as on certain additional
types of materials (such as audio-visual materials) within their own local library system. Items which are
placed on hold will be delivered via courier from the owning library to the patron's desired pickup library.
Materials will retain the same circulation period regardless of whether the patron is local or from another
PINES library. When thinking of intra-PINES lending, it is important to remember that a PINES patron is a
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patron exactly like your local patron. Intra-PINES loans are not ILLs – they are simply circulations like any
other. The PINES Executive Committee has ruled that circulations between PINES libraries must be free of
charge to system libraries and to patrons [2008.09].
The vision of the PINES statewide library card included as a key component the ability for patrons to see
and borrow library materials from all participating public libraries in the state. Our goal is maximum
access for all patrons, while realistically addressing the logistics of moving materials around the state.
Member libraries have agreed that PINES membership would not relieve libraries of the responsibility for
purchasing the materials needed to meet the demands of local patrons.
Staﬀ must never give preference to one patron over another regarding holds. The PINES code of ethics
requires that all libraries respect the integrity of the hold queue, and share equitably.

Placing Holds
Patrons may place their own holds via the OPAC, and may select their pickup location and
notiﬁcation method. The software will refuse holds requests which do not conform to PINES policies.
Patrons may choose any pickup location for holds. Patrons may not place multiple holds on a single
title record, but staﬀ may place multiple holds on a single title record on behalf of the patron (e.g.,
for a book club) [2006.05].
Patrons whose PINES cards are expired will not be allowed to place holds until the card privilege is
renewed.
Most patrons may place 50 holds at any given time on their account [2006.11]. Certain user
categories are restricted to diﬀerent number of holds limits.
If a patron presents the on-hold item for checkout before it is retrieved for the requesting patron,
the in-house patron with item in hand receives preference; a circulation supervisor will override the
hold and check out the item to the in-house patron. The requesting patron will be next in line for
the item.
Hold requests expire after 6 months with the option for staﬀ or patron to make it an earlier or later
date [2008.02].

Pulling Holds
An automated process (the Holds Targeter) runs periodically throughout the day and identiﬁes copies of
items at PINES libraries that can fulﬁll holds.
Each weekday (M-F) morning, each PINES library location will print a report (the Pull List) of items on their
shelves which have hold requests (Circulation > Pull List for Hold Requests). The items on this list should
be retrieved from the shelves and processed within 24 hours.
If an item should be on the shelf but cannot be found, mark the item Missing (Circulation > Item Status >
Scan Barcode > Actions > Mark Item as Missing). This will direct the Holds Targeter to look for a diﬀerent
copy of the item within PINES. It will also allow you to generate a report of missing items in your library.
If you receive an inappropriate holds request on your list (for an item type that is not eligible for intraPINES Documentation - https://pines.georgialibraries.org/dokuwiki/
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PINES loans), contact the requesting library via e-mail or telephone and ask them to remove the hold.
Please DO NOT ignore such holds, as they will continue to appear on your list each day until they are
resolved.
Libraries may choose to pull and process holds more than once per day if desired, and may also choose
to pull and process holds on weekend days if desired.

Processing Holds
After pulling items from the shelves (or when receiving items routed to your location to fulﬁll a hold from
another location), scan them into the Checkin Interface (Circulation > Capture Holds).
If the item being scanned is on hold for a local patron, the system will print a Hold Slip that contains the
patron’s contact information. If the patron has chosen to be notiﬁed by email, an email will be
automatically generated within the hour and sent to the address on ﬁle. If the patron has chosen to be
notiﬁed by telephone, then staﬀ must call the patron. The item should then be placed on the Holds Shelf.
If the item being scanned is on hold for a patron of another location, the system will print a Transit Slip
and staﬀ will place the item in transit. Items should be appropriately packaged to protect them from
damage while in transit [2008.11]. All materials should be treated the same as each library would want
its own materials handled [2009.05].
Holds that are not processed within 24 hours will be re-targeted to another library if possible. For 5
days, the hold targeter will only select items within the pickup library. After 5 days, the hold may
be ﬁlled by any copy within PINES [2007.12]. Borrowed items should be promptly sent back to the
owning library or on to the next library to ﬁll a hold.
A database of PINES delivery addresses in mailing label format is provided to each library (see
Library Routing, Courier, and Contact Info); you can print out the addresses needed on demand. For
convenience, the Evergreen receipt templates for transit items can be conﬁgured to print the
library policy name and courier code for each item (see Print Templates). All items should be sent
out within 24 hours of receipt of the holds list.
Holds notices will be emailed within an hour of when the item is available for those patrons who
have email addresses in their user records and who have chosen to be notiﬁed by email. Each
library is responsible for contacting users who have chosen to be telephoned regarding available
holds. No paper notices will be mailed centrally.
Holds will also be captured in the normal course of checking in items. These holds should be
processed and routed within 24 hours.

The Holds Shelf
Each library may decide how long to keep its own items on the holds pickup shelf; however, items from
outside the local library system should be held on the holds shelf for a maximum of seven (7) open
business days [2009.05], then returned to the owning library or forwarded to the next person waiting in
line for a hold.
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Clearing the Holds Shelf
Staﬀ should monitor the holds shelf and remove items that have not been picked up within the
designated amount of time or whose holds have been cancelled.
Identify the holds which should be placed back into circulation.
1. View the holds shelf (Circulation > Holds Shelf). The list you see should match the books that are
actually present on your holds shelf. (Sorting is not available in the 2.12 web client, but is targeted
to be available in the 3.0 web client.)
2. Determine which items should be pulled oﬀ of the holds shelf.
If you check the View Clearable Holds box, it will show you which items have been on the
holds shelf for more than 7 days.
The Available On column displays the date that the item was actually placed on the holds
shelf.
Each library system may determine how many days to allow their own items to remain on the
holds shelf. However, items belonging to a diﬀerent library system should not be held for
more than 7 days.
3. Scan the items in the Checkin interface using the ‘Clear Holds Shelf’ Checkin Modiﬁer (see Checkin
Modiﬁers).
If you have checked the View Clearable Holds box and you press the Clear These Holds
button, the current holds for the listed items are all cancelled at once, but their item status
will still read 'On holds shelf' until you check the items in. If you use this method, you do not
need to use the 'Clear Holds Shelf' Checkin Modiﬁer, you can just check the books in as
normal.
If you use the 'Clear Holds Shelf' Checkin Modiﬁer, be sure to disable the modiﬁer before
checking in other books. (On the Check In screen, press the Checkin Modiﬁers button on the
bottom-right of the screen and select Clear Holds Shelf to remove the checkmark.)

Checking in Returned Holds
When a patron returns an item that is owned by another library, the system will print out a transit slip
directing the staﬀ to return the item to the owning library (or to the next location waiting for a hold on
the item). Route these items to the appropriate location within 24 hours of their return.

Suspending Holds
A hold can be placed on an item and then suspended (inactivated) until a later date by staﬀ or the
patron. The holds targeter will ignore these holds while they are inactive.
If an activation date is set, the system will automatically reactivate the hold on the set date. If not, the
hold will not reactivate until manually reactivated by the patron or by library staﬀ.
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Changing the Pickup Location of a Hold
A staﬀ member or a patron may change the pickup library of a hold after the hold has been placed. Once
the pickup location has been changed, the item needs to be scanned on the checkin screen to place it in
transit to the correct pickup library.
A patron may change the pickup location of a hold by going to My Account > Holds, then clicking the
'Edit' link next to the title.
Staﬀ may change the pickup location of a hold from the Holds Shelf screen or from the Patron's Hold
screen (Actions > Edit Pickup Library).
If the hold has its pickup library changed while it is in transit to the original pickup library, when it arrives
and is scanned in, it will print a new transit slip to the new pickup library.
If the hold has its pickup library changed after it has already arrived at the original pickup library, the
Status on the Holds Shelf screen will say 'Wrong Shelf.' If staﬀ see the Wrong Shelf status, staﬀ should rescan the item on the check in screen in order to place it into transit to the new destination.

Holds Behind Circ Desk
A library may choose to have the holds shelf located in a staﬀ-only area or in a public area where patrons
can retrieve their own holds. Libraries that have public holds shelves can oﬀer patrons the ability to
request that their holds are placed in a private area. To make use of this feature, the library should set
the “Behind Desk Pickup Supported” option to “true” in the Library Settings Editor. This will display a
“Hold is behind Circ Desk” option on the patron information screen. Hold slips for these patrons will print
with the notation “PRIVATE HOLDS SHELF” and all other hold slips will print with the notation “PUBLIC
HOLDS SHELF” [2014.05].

Restricted Holds on Age-Protected Items and Audio-Visual
Materials
Audio-visual items and age-protected items are only available for holds by patrons registered to the
owning library/region, and are only available for pickup within the item's owning system. [2007.02]

A-V Items and Other Restricted Items
Under normal circumstance, PINES does not allow intra-PINES loans on the following item categories:
Audiobooks
CDs
Deposit (monetary)
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DVDs
Bestsellers
Equipment
Leased Materials
Microforms
New Books
Outreach
Reference
Reserve
Software
Toy
Videocassettes
Video Games
Items of these types may be placed on hold only within regional library systems. Leased items will be
treated the same as any other book with regards to holds [2006.11].
For other item types, a title-level hold will ﬁnd the ﬁrst available copy of the title in PINES to ﬁll the hold.
The Holds report will ﬁrst look for an available copy in the patron’s pickup library, then in the pickup
library’s system; if no copy is available, it will then select a copy from another PINES library.
The Executive Committee has approved a special reciprocal arrangement for Dougherty County Public
Library and Lee County Library regarding holds restrictions in all formats (except new items). Lee County
and Dougherty County patrons are allowed to place their own holds on either system’s restricted formats
with the exception of age-protected items. This exemption only aﬀects DCPL and LEE home library
patrons. [2007.12]

Age Protection
Age Protection allows libraries to prevent holds on new books (on a copy by copy basis) from outside the
owning library's branch or system for a designated amount of time. The purpose of this is to give the
library's local patrons a chance to check out the new book before sending it oﬀ to other libraries.
Libraries typically use this feature for popular ﬁction, but may also choose to use it for any or all other
new books.
Each item (copy) has an “age_protect” ﬂag which may be set to 3 month, 6 month, or None (based on
the item's activation date):
If set to “3 month” and the item was made active less than 3 months ago, the item is only holdable
by patrons whose home library matches the circulating library of the copy. (Note: The system
interprets 3 months as 90 days.) After 3 months, the item will automatically roll over to 6 month
age protection.
If “6 month” is set and the item was made active less than 6 months ago, the item is only holdable
by patrons whose home library is within the same system as the circulating library of the item.
(Note: The system interprets 6 months as 180 days.) After 6 months is over, the item will no longer
be age protected and holds may be placed on it from any PINES location, but the age_protect ﬂag
will still appear as “6 month.”
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If age protect is set to None, then no age protection occurs and the holds can be placed on the
item from any PINES location.

Holds on Multi-Part Items
See: Instructions for Circulation and Reference Staﬀ (Video)

Holds on Multi-Part Items
See: Instructions for Circulation and Reference Staﬀ (Video)
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Bills
To encourage the prompt return of materials, the PINES libraries have established a schedule of ﬁnes and
fees as penalty to those patrons who fail to return materials by their due dates. The schedule of ﬁnes and
fees can be found with the PINES Circulation Matrix.
See: PINES Circulation Matrix
Historical Note: On July 1, 2012, the ﬁne rate for books increased from $0.15 to $0.20 per day [2012.05].

Paying Fines/Fees
PINES ﬁnes may be paid at any participating library. If the patron's home library is conﬁgured to accept
online credit card payments, then that patron may also log in to the “My Account” section of the OPAC
and pay their bills online.
Returned materials which are owned by other PINES libraries will be promptly returned via the PINES
courier service. Patrons may pay all or a portion of overdue ﬁnes. Patrons are not allowed to carry a
credit balance of ﬁnes on their account in lieu of a refund [2006.05].
PINES library systems may choose to implement “ﬁne-free” or “food-for-ﬁnes” library promotions. These
will apply only to items owned by the initiating library systems. The participating library/system must
make it clear to the public that these promotions are local and do not apply to other PINES libraries.
[2001.11].
Returned check charges should be billed to the user's account. Payment is due from the patron that
caused the loss to the library that incurred the loss [2011.05].
See also: Collection/Materials Recovery Agencies
See also: Payment Retention and Reimbursal
See also: Unrecovered Debt
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Collection/Materials Recovery Agencies
Some PINES libraries contract with collection/materials recovery agencies to collect outstanding ﬁnes and
fees or to recover lost materials. The following policies and procedures apply to this arrangement within
PINES:
A library may send any patrons to collections who have overdue materials as a result of
transactions originating from the library in question, regardless of item ownership or patron home
library [2007.05].
When a patron is referred to collections, a Note or Alert should be added to the patron account to
indicate which library took action.
Only the referring library may remove the collections status.
Patron accounts in collections status may be paid at any PINES library. Payments will be retained
by the collection library unless the owning library sends an invoice for payment reimbursal to the
collection library within 90 days of the payment date. [2018.09] Collection agency fees that are
automatically added to the accounts that have been referred to collections may also be invoiced if
they are paid at the non-referring library.
Prior to September 2018, patrons whose accounts were in collections status were required to pay their
bill at the referring library [2003.05].
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Credit Card Payments
At the Desk
Libraries may contract with the credit card processing vendor of choice (many libraries have chosen
Square) to accept credit card payments at the desk. These vendors are not connected to PINES, so any
payments that are accepted in this way will need to also be entered by staﬀ in order to update the
patron's account.

Through the OPAC
Libraries may opt to take credit card payments online through the OPAC. When patrons log in to My
Account, if their home library has credit card payments enabled then they will see the ability to pay
online. (If the home library does not have credit card payments enabled, the patron will just see the ﬁne
information, but not the option to pay online.)
Stripe
To date, every PINES library that has opted to accept credit card payments has chosen Stripe as the
vendor of choice.
1. Set up an account with Stripe
http://www.stripe.com
A single account can be created for all branches in the regional system, or separate accounts
can be created for each branch.
2. After setup, Stripe will provide you with four keys for each account.
test private key, test public key, live private key, live public key
3. Submit a Help Desk ticket with the four keys and which system or branch they should be applied
to.
4. PINES staﬀ will enable the appropriate options on your account and patrons will be able to begin
online payments immediately.
Other Vendors
Evergreen is also capable of connecting with Authorize.net and with PayPal. If you wish to use one of
those vendors instead of Stripe, contact the Help Desk for assistance.
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Deposit-Handling Suggestions
Some PINES libraries choose to require deposits in order to check out certain high-value or high-loss
materials such as test preparation (GED, ASVAB, etc.) books.
A library system that chooses to require deposits on select items will determine its own local procedures
for handling deposits. This page consists of suggestions based on the existing practices of various PINES
library systems, but while one approach may work for one library, it may not work for another depending
on staﬃng structure and the way that funds are held and balanced. Please use the following information
as suggestions only and be sure that whatever procedure you follow within your own library system is
consistent, clearly documented, and follows all money-handling guidelines your system is required to
follow.

General Notes
The library system will determine which items will require deposits.
The library system will determine whether or not to place copy alerts on the item's record.
The library system will determine the amount of the deposit required for the item.
The library system will determine where the deposit items are stored (most libraries store them
behind the desk).
The library system may choose to set up the copy record so that it will bill the patron account
automatically upon checkout. Other libraries may choose to add bills to the patron accounts
manually.
Some library systems place stickers on the cover of the books indicating that deposit is required
and stating the amount of the deposit required.
Some library systems will accept non-monetary items (such as a driver's license) instead of a cash
deposit for items that are for in-house use only. These situations are not typically logged in detail.
Some library systems choose to use the Evergreen software to track deposits and refunded
deposits, but others choose to create paper logs manually. If a library is required to reconcile its
cash drawer with the cash report produced by Evergreen, then the library might prefer handling
the deposit money separately from Evergreen for bookkeeping simplicity. However, if it is more
important to a library to track the deposited funds and returned deposits within the patron
accounts, then the library might prefer handling the deposits within Evergreen. Each library system
should determine what approach works best for their individual situation.
It is good practice to have the guidelines and procedures for deposits posted publicly (perhaps at
the circulation desk or on the library's web site) so that the library's patrons can easily refer to
them. One library system even takes the extra step of providing borrowers of these items with
bookmarks that remind them to pick up their deposits when they return the items. The bookmark
informs them that if the item is long overdue or lost, the deposit will go towards the cost of the
item. It also informs them that if the person has returned the item but has not picked up their
deposit, the deposit will be considered a donation.
PINES policy states that items requiring deposits should be non-holdable outside their own library
systems, but the software does not currently have this functionality.
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Managing Deposits Manually
Checkout
Staﬀ accepts the deposit (check or cash) and places it in a secure location. Libraries typically place the
deposit in an envelope or bag (such as a pencil bag) labelled with the patron's name, library card
number, date of checkout, book title, and barcode. Some libraries also keep a deposit log that patrons
sign when they make a deposit and when they receive their returned deposit - this log is useful to have in
case someone claims to have not received their returned deposit. It is good practice to have the library
staﬀ members that receive and return the deposits initial and date the log entry and/or envelope as well.
Renewal
If the patron wishes to renew the item, any alert is overridden and the patron is not required to provide a
second deposit.
Return
When the patron returns the item, the staﬀ will return the deposit that was being kept aside for the
patron. If the item is labelled or has a copy alert on it, then the staﬀ processing the returned item should
notice that the patron is due the returned deposit. If the library is keeping a paper log, then the patron
should sign that he or she received the returned deposit.

Managing Deposits with Evergreen
Checkout
The patron is billed for the deposit amount. This can be set up to happen automatically or the staﬀ
member can add it manually by opening the patron's account then clicking Bills > Bill Patron. If adding
manually, the staﬀ member should choose “Deposit Fee” as the Billing Type and enter the item's title
and barcode, as well as the staﬀ member's initials, location, and date.
Staﬀ accepts payment for the bill and records the payment to the account (select the appropriate billing
line item, choose the Payment Type, enter the amount of Payment Received, then click Apply Payment).
Doing this ensures that the bill does not go above $10 due to a deposit charge and that there is a record
of the transaction on the account.
Staﬀ places the deposit in a secure location (typically in an envelope labelled with the patron's name,
library card number, date of checkout, book title, and barcode) and if necessary, records the amount in a
paper log as well.
Renewal
If the item is set up to the bill the patron automatically and the patron renews the item, the patron will be
billed a second time. If this occurs, staﬀ should Void that bill.

PINES Documentation - https://pines.georgialibraries.org/dokuwiki/

2018/10/26 16:39

134/147

PINES Circulation Policies and Procedures Manual

Return
When the patron returns the item, go to Bills > History > select the appropriate Bill and click Full Details.
You should see that the Deposit fee was charged and paid. Close the pop-up window.
On the Bills > History screen, click Add Billing. Choose Billing Type of “Refund: Deposit Item Returned”
with an amount of zero (0) and enter an annotation with the staﬀ initials, date, and location. (After
saving, if you look at the Full Details, you will see that it added a line item to the bill indicating that the
deposit had been returned.)
Staﬀ returns the deposit that was being kept aside for the patron. If the library is also keeping a paper
log, then the patron should sign that he or she received the returned deposit.

When a Patron Does Not Return the Item
If the book is not returned and ends up marked Long Overdue or Lost, the library may credit the deposit
against the price of the book. If a personal check was used as a deposit, the library may wish to resolve
the issue sooner rather than later because the personal check may no longer be valid after several
months.

When a Patron Does Not Pick Up the Deposit
If an item has been returned but the patron has not picked up the deposit, it is good practice to place an
alert on the patron's account so that the deposit may be returned on the patron's next visit. If the deposit
has not been picked up after a pre-determined amount of time, the library may consider it a donation
(the library's policy on this should be clearly indicated in the documentation).
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Max Fines vs. Max Bills
The terms 'Max Fines' and 'Max Bills' can be easily confused, so the descriptions below are written to
distinguish between the two.

Maximum Bills
Relates to patrons.
Once a PINES patron reaches (or surpasses) $10.00 in ﬁnes and fees, the patron's account is
automatically blocked. The patron will be unable to check out or renew items until the total amount owed
on his or her account drops below $10.00.
Depending on which local library system the patron uses, the patron might also lose access to public
computers and downloadable ebooks/audiobooks. There is no maximum limit on how high a patron's bills
might go, although many PINES libraries will refer patrons to collection agencies once they reach a
certain point and do not pay it within a certain amount of time.

Max Fine Levels
Relates to items.
Each library system within PINES chooses the Max Fine Level they wish to use for overdue ﬁnes. Most
library systems use $5.00, but a few use a higher amount (see the PINES Circulation Matrix). If the Max
Fine Level is set to $5.00, then overdue ﬁnes on an item will accrue each day the item is overdue until
the ﬁnes reach $5.00 and will then stop. If the patron has multiple items checked out and overdue, then
the ﬁnes on each one will accrue until each of them reach $5.00.
If an item is not returned and marked as either Lost or Long Overdue, the overdue ﬁnes are removed and
the patron is billed for the cost of the item instead. Some library systems will also charge a nonrefundable processing fee if this happens.
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Negative Balances
There are several scenarios that may result in a patron account showing a negative balance or credit.
PINES policy states that patrons are not allowed to carry a credit balance on their account, so accounts
that show negative balances should be reviewed regularly and balanced.

Obtaining a List of Patrons with Negative Balances
Open the Evergreen Staﬀ Client and go to: Administration > Local Administration > Patrons with
Negative Balances
This screen may take some time to load. It will default to the library location that your workstation is
registered to. After it loads, you may select a diﬀerent library location.
Double-click on any resulting patron to open that patron's record.

Investigating a Negative Balance
1. Open the patron's account in the Evergreen Staﬀ Client and click on Bills.
2. Review the bills to determine the cause of the negative balance.
3. Right-click on a line item and View Full Details to see detailed information about that bill number.
This shows each charge (including voided charges) and each payment that was applied to that bill
number. If an item has been both voided and forgiven, or voided and paid for, or forgiven and paid
for, you should see evidence of it on this screen.
4. You may also wish to look at the history (from the main Bills screen, click the History button). From
here you may view all Transactions or limit to all Payments for any speciﬁed time period.

Correcting a Negative Balance Caused by a Bill Being Forgiven
and Voided
If you see that charges were voided under the Bills section, but also paid or forgiven under the Payments
section, then that would explain how the bill number ended up with a credit that should not be there. To
correct this, add a bill to that bill number for the amount of the incorrect credit:
1. From the patron's account, open the Bills screen.
2. Right-click on a listed bill and click Full Details to conﬁrm that the problem is that a bill was both
voided and forgiven.
3. Return to the main Bills screen.
4. Right-click on the bill and click Add Billing.
5. A pop-up window will open.
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6. Choose Miscellaneous as the Billing Type.
7. Enter the Amount needed to balance the bill (if the balance owed showed -2.60, then enter 2.60).
8. Enter a detailed Note explaining the added bill (for example, “Bill #12345 - Fines were forgiven and
voided in error. Adding bill for $2.60 to balance the account. TMcCanna STATELIB-A 1/25/2018”)
9. Click Submit Bill.
10. Click the Refresh button to refresh the main Bills screen to see the balanced account - this is
sometimes cached and you may need to close the patron account and reopen it to see the
balanced account.
See Also:
Walkthrough - Negative balance caused by a bill being forgiven and voided
Walkthrough - Correcting problems caused by an incorrect attempt to ﬁx a negative balance

Correcting a Negative Balance Caused by a Lost Item Being
Paid for and then Found
PINES policy states that if a lost item is paid for in full, but then found and returned by the patron within
six months (180 days) of payment, then the owning library should refund the payment minus any
overdue fees that had been automatically voided when the item was marked lost, and minus any
processing fees which had been applied.
1. From the main Bills screen on the patron's account, right-click on the bill that is incorrectly showing
a negative balance.
2. Click Full Details to conﬁrm that the problem is that an item was paid for (the payment information
should be in the Payments section) and then voided (in the Bills section, Voided will be 'Yes' and
the Note will say 'VOIDED FOR LOST ITEM RETURNED' on the charge for Lost Materials).
3. Review the payment date and the Voided date to conﬁrm that the item was returned within 6
months (180 days) of payment. If the item was returned after that date, then no refund is due to
the patron. If it was within that 6 months, then the patron is due the amount they paid minus any
overdue charges that had been voided, minus any processing fee. Make a note of how much
money is actually owed to the patron for a refund.
4. Return to the main Bills screen.
5. Conﬁrm that the amount showing as owed to the patron matches what you have calculated in your
investigation. If the displayed number is incorrect due to other billing issues or errors, correct each
of them until the amount shown is correct.
6. From the Bills screen, click Check All Refunds.
7. Check the Annotate Payment box.
8. Click Apply Payment.
9. Enter annotation (for example, “Refund check request for $9.99 sent to business oﬃce on
6/25/2014 TMcCanna”).
10. Click OK.
11. Diﬀerent library systems have diﬀerent procedures for processing refunds, but most will have a
form to ﬁll out that goes to their business oﬃce to request that a check be cut and sent to the
patron. Give a of the receipt to the patron indicating the amount of the refund they should expect
to receive. Attach a copy of the receipt to your check request form to send to your library's
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business oﬃce. Put a copy of the receipt in your cash drawer for your records.
12. Click the Refresh button to refresh the main Bills screen to see the balanced account - this is
sometimes cached and you may need to close the patron account and reopen it to see the
balanced account.

Sources of Confusion
There are a few options you might encounter in the Evergreen Staﬀ Client that do not work the way you
might expect them to for PINES, so we recommend that you do not use them.
If you right-click on a bill and click Refund, it will add the dollar amount to the Payment Pending
column, but does not complete the Refund. You would still need to click Apply Payment to complete
the process. For PINES libraries doing refunds, it is usually better to click Check All Refunds and
then Apply Payment.
If you right-click on a bill and click Add Billing, one of the Billing Types is Refund: Lost Item
Returned. If you use this, it may appear to balance the account (unless there are other ﬁnes and
fees on the account), but the transactions will not show up under Bill History. For PINES libraries
doing refunds, it is usually better to click Check All Refunds and then Apply Payment.

Help Desk
If you are unable to identify the cause of the negative balance or unable to correct it, please submit a
detailed Help Desk ticket.
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Processing fees for lost and long overdue items are determined independently by each library system. If
a lost or long overdue item is paid for but then found and returned within 180 days of the payment date,
the amount paid should be refunded minus the item's overdue fees and processing fee.

PINES Policy
Name

Branch

System Name

ARL

All locations

ARCPLS

All locations

BROOK
BTRL
CCL
CHAT
CHRL
CLAYTN
CPRL
CRLS
DCPL
DTRL-BAKR

DTRL-SALECITY
ECPL
FRRLS
GCHR
HALL
HART
HCLS
HOU
JCL
KRLS

All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
Baker County Library
Blakely-Maddox
Memorial Library
Camilla-DeSoto Trail
Regional Library
Jakin Public Library
Pelham-Pelham Carnegie
Library
Sale City Library
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations

Athens Regional Library System
Augusta-Richmond County Public
Library
Brooks County Public Library
Bartram Trail Regional Library
Catoosa County Library
Chattooga County Library
Cherokee Regional Library
Clayton County Library System
Coastal Plain Regional Library
Chestatee Regional Library System
Dougherty County Public Library
Desoto Trail Regional Library

LBRLS

All locations

LEE
LOPL
MCCLS
MGRL
MOGL

All locations
All locations
All locations
All locations
All locations

DTRL-BLAK
DTRL-CAMI
DTRL-JAKN
DTRL-PELH

Processing
Fees (Lost /
Long Overdue /
Damaged*)
10/10/10
5/5/5
0/0/0
10/10/10
0/0/0
5/5/5
3/3/3
10/0/0
5/5/5
10/10/10
10/10/10
5/5/5

Desoto Trail Regional Library

5/5/5

Desoto Trail Regional Library

5/5/5

Desoto Trail Regional Library

5/5/5

Desoto Trail Regional Library

5/5/5

Desoto Trail Regional Library
Elbert County Public Library
Flint River Regional Library
Greater Clarks Hill Regional Library
Hall County Library System
Hart County Library System
Henry County Library
Houston County Public Library
Jeﬀerson County Library
Kinchafoonee Regional Library
Lake Blackshear Regional Library
System
Lee County Public Library
Live Oak Public Library
Moultrie-Colquitt County Library
Middle Georgia Regional Library
Marshes of Glynn Libraries

0/0/0
0/0/0
10/10/10
5/5/5
5/5/5
10/10/10
10/10/10
5/5/5
0/0/0
5/5/5
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Branch

MRLS
NCLS
NEG
NGRL
OCRL
OHOOP
OKRL
ORLS
PIED
PMRLS
PPL
RML
ROCK
SGRL
SHRL-BK
SHRL-CD
SHRL-CS
SHRL-RK
SHRL-RM
SJRLS
SRL
STATELIB
STRL
SWGRL
TCPLS
THRL
TLLS
TRRLS
URRLS
WGRL
WORTH

All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
Outreach Collection
Cedartown Branch
Cave Spring Branch
Rockmart Branch
Rome Branch
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
All locations
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Processing
Fees (Lost /
System Name
Long Overdue /
Damaged*)
Mountain Regional Library
10/10/10
Newton County Library System
10/10/10
Northeast Georgia Regional Library
0/0/0
Northwest Georgia Regional Library
4/4/4
Oconee Regional Library
0/0/0
Ohoopee Regional Library System
5/5/5
Okefenokee Regional Library System
5/5/5
Ocmulgee Regional Library System
0/0/0
Piedmont Regional Library System
5/5/5
Pine Mountain Regional Library System 5/5/5
Peach Public Libraries
10/10/10
Roddenbery Memorial Library
10/10/10
Conyers-Rockdale Library System
5/5/5
South Georgia Regional Library System 0/0/0
Sara Hightower Regional Library
0/0/0
Sara Hightower Regional Library
5/5/5
Sara Hightower Regional Library
5/5/5
Sara Hightower Regional Library
5/5/5
Sara Hightower Regional Library
5/5/5
Screven-Jenkins Regional Library
5/5/5
Satilla Regional Library
0/0/0
Georgia Public Library Service
0/0/0
Statesboro Regional Library
0/0/0
Southwest Georgia Regional Library
0/0/0
Thomas County Public Library System 0/0/0
Troup-Harris Regional Library
5/5/5
Twin Lakes Library System
10/10/10
Three Rivers Regional Library
5/5/5
Uncle Remus Regional Library System 10/10/10
West Georgia Regional Library
3/3/3
Worth County Library System
0/0/0

* Damaged item processing fees were implemented on July 1, 2017. The Damaged Item processing fee is
only automatically applied when the full item price is billed.
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Payment Retention and Reimbursal
Overdue ﬁnes will be retained by the collecting library, regardless of the original lending library
[1999.10]. Payments for lost, damaged, or long overdue materials (along with any associated processing
fees) will be retained by the collecting library unless the owning library sends an invoice for payment
reimbursal to the collecting library within 90 days of the payment date [2016.09]. Collection agency fees
that are paid at the non-referring library may also be invoiced [2018.09].

Reports
The following Quick Reports are available to assist you in identifying payments that your library may
request reimbursal for. Each line item on the resulting report must be investigated to determine the
actual reimbursal amount, because the report is unable to determine partial payments, payments
covering multiple bills, and payments that have already been refunded. There are three reports: the
'circulation' report includes payments that were made at a library on bills that the system created, the
'grocery' report includes payments that were made at a library on bills that were manually created, and
the 'OPAC' report includes payments that were made via the OPAC on both circ and grocery bills.
PINES Quick Reports > Quick Report Templates > Bills > Invoice Report: Circulation Bills
PINES Quick Reports > Quick Report Templates > Bills > Invoice Report: Grocery Bills
PINES Quick Reports > Quick Report Templates > Bills > Invoice Report: OPAC Payments

Invoices
Invoices should be sent to the Headquarters Library for each system within 90 days of payment.
You may use the attached invoice below, or you may use your own library's standard invoice format as
long as the following information is included:
Bill Number
Type of Bill (Lost, Long Overdue, Damaged, Collection Agency Fee)
Payment Date
Patron Barcode
Patron Name
Item Barcode
Item Title
Sample Invoice
When sending payment for an invoice, a copy of the invoice should be included with the payment.
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Patrons in Collections
See: Collection/Materials Recovery Agencies
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Unrecovered Debt / Uncollectable Debt
In 2007, the following procedure was agreed upon. However, the library director that requested the
development left PINES before development was done, and the project was cancelled:
“As a measure to bring library accounting practices in line with Governmental Accounting Standards
Board regulations, the Executive Committee has decided to adopt a procedure for marking ﬁnes/fees
owed by patrons for over three years “unrecovered debt.” This status will be applied at the percirculation-transaction level to such ﬁnes and fees [2007.09].”
At this time, each library system is responsible for developing its own procedures for handling old,
'unrecoverable' debt on patron accounts.
See Also:
Legal opinions regarding old debt, page 18+
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Automated Notiﬁcations
PINES generates automated notices for a number of reasons and sends various notices by email, SMS
text (a form of email that gets translated to text message by the recipient’s phone service provider), and
for display in the Patron Message Center. The text of each type of notice is available here:
The automated notices include:
10 Day Overdue Email Notiﬁcation
10 Day Overdue Notice in PMC
3 Day Courtesy Notice (by Email)
3 Day Courtesy Notice by SMS
3 Day Courtesy Notice in PMC
30 Day Account Expiration Courtesy Notice
6 Month Long Overdue Notice (Email)
6 Month Long Overdue Notice in PMC
Hold Cancelled (Shelf-Expired) Email Notiﬁcation
Hold Cancelled (Shelf-Expired) User Message (PMC)
Hold Ready for Pickup Email Notiﬁcation
Hold Ready for Pickup PMC Notiﬁcation
Hold Ready for Pickup SMS Notiﬁcation
Item Lost and Billed Email Notiﬁcation
Item Lost and Billed PMC Notiﬁcation
New User Created Welcome Notice
Password Reset Request Notiﬁcation
SMS Call Number
See also: Wording of Automated Notices
In addition, PINES contracts with a vendor for the following:
10 day overdue notice (Email attempt ﬁrst, phone call if email fails, USPS mail if both email and
phone fail)
30 day overdue letter sent by USPS
Letters that cannot be delivered are returned to the patron's home library. The library should mark those
patrons' addresses invalid when this occurs.

Typical Notiﬁcations for an Overdue Item
1. 3 Day Courtesy Notice sent 3 days prior to due date by email (if available) and SMS text (if
available), and entered into Patron Message Center.
2. 10 Day Overdue Notice sent by email (if available) and entered into Patron Message Center. Vendor
also telephones patrons who do not have a valid email recorded in PINES, and if they cannot be
reached by phone then vendor sends a letter.
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3. 30 Day Overdue letter sent by vendor.
4. 6 Month Long Overdue Notice sent by email (if available) and entered into Patron Message Center.

Pre-Overdue Notices ("Preminders")
PINES sends a “pre-overdue” or “preminder” courtesy notice via email 3-days prior to the due date of an
item [2007.05]. Beginning January 2017, PINES also began sending preminders via SMS text service.
Patrons should be aware that although PINES sends preminders, it is a courtesy only. Some email and
SMS text providers may block the preminder emails at the server level, preventing them from arriving at
their destinations. The patron is ultimately responsible for returning or renewing items by their due dates
whether or not the preminders are received.

Overdue Notices
Overdue notices are sent as a courtesy from the libraries. Failure to receive notices does not exempt
patrons from the responsibility for library materials or overdue ﬁnes. Notices are generated and mailed
centrally.
The ﬁrst overdue notice is generated at 10 days past the due date of an item. These 10-day overdue
notices are sent via email to those patrons with email addresses in their user records [2007.02], and
patrons without email addresses are telephoned (via a telephone notice service that PINES contracts
with) [2011.05].
The ﬁnal (30-day) overdue notice is sent via US Mail.
Historical Note: The Executive Committee voted that PINES will issue 7- and 14-day overdue notices to
patrons. Mandatory budget reductions for GPLS in summer 2009 necessitated a change to a single 10day notice to replace the 7- and 14-day notices. The 30-day notice remains intact, as required by Georgia
law [1999.10], [2009.09].
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Library Cards
Library Card Design
Any new card designs for PINES must be approved by the PINES Director, the PINES Communications
Department, and the State Librarian [2016.12].

Library Card Orders
Library cards are purchased directly by each library system. Libraries may use any vendor as long as the
card design, barcode format, and numbering sequence are consistent with PINES standards.
See also: Library Card and Barcode Ordering Information and Patron Card Sequences
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